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Section 1

Getting Started



Section 1A

System Requirements

The minimum system requirements for installation and operation of Sprint SmartView are 
shown in the table below.

Additional Requirements
● Windows Vista operation requires DirectX 9.0 (or better) Graphics Accelerator

● Internet Connection (if downloading the installer from the Internet)

● CD-ROM (if installing from CD)

Windows 2000 Windows XP Windows VIsta

Processor 233 MHz 300 MHz
800 MHz (1 GHz 
recommended)

RAM 256 MB 256 MB
1 GB (2 GB 

recommended)

Hard Drive Space 70 MB 70 MB 70 MB

Internet Explorer IE 5.5 (or higher) IE 5.5 (or higher) IE 7 (or higher)

Windows Service Pack
Service Pack 4 (or 

higher)
Service Pack 2 (or 

higher)
-

7        Section 1A. System Requirements
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Section 1B

Installing the Drivers for Your Wireless Devices

Before you connect with a wireless device, you will need to ensure that the device’s drivers 
are properly installed.

WiFi Devices
If a WiFi device came preinstalled on your computer, its drivers have most likely already 
been installed by the computer manufacturer. 

If you purchased a WiFi device separately and have not already done so, you should install 
the drivers for the device before proceeding.

Sprint Mobile Broadband Devices
All Sprint Mobile Broadband devices come with a printed Quick Start Guide that contains 
instructions for device setup, including driver installation, which typically involves the 
following steps:

1. Plug the device into the appropriate PC Card, Express Card, or USB Slot. You will see 
a small icon at the bottom right of the screen indicating that Windows has discovered 
new hardware, and that the device drivers are being installed for it.

2. After the installation finishes, you will receive a confirmation message at the bottom 
right of your screen stating that the new hardware was installed successfully and is 
ready to use.

Section 1C

Installing Sprint SmartView

Your Sprint Mobile Broadband device includes a copy of Sprint SmartView, residing either 
on the device or on an installation CD.

If the installer is preloaded on your device, you will be prompted to install Sprint SmartView 
when you connect the device to your computer.

If your device came with an installation CD, simply insert the CD in your computer’s CD-
ROM or DVD-ROM drive, and the installer should run automatically.

For detailed instructions on installing Sprint SmartView, consult the printed Quick Start 
Guide.

Note The Sprint SmartView Software can also be downloaded from www.sprint.com/
downloads.
Section 1B. Installing the Drivers for Your Wireless Devices        8



Section 1D

Launching Sprint SmartView

Once your hardware is installed and ready to connect, you may go ahead and launch Sprint 
SmartView by doing one of the following:

● Double-click the Sprint SmartView Icon on your computer’s desktop

● In the Start menu, select Programs or All Programs > Sprint > Sprint SmartView

Section 1E

Device Activation

Some Mobile Broadband Devices may require activation (programming) prior to use. If your 
device needs activation, Sprint SmartView will inform you and start the activation process when 
you connect the device. Although the activation process will vary depending on the make, 
model and firmware version of your device, all activations fall into one of the following 
categories:

● Hands-Free Activation — Sprint SmartView will simply inform you that it is activating your 
device and periodically give you updates about activation status. No intervention is 
required on your part. 
Although you have the option to cancel the activation process at any time, you will not be 
able to use the device for data connections until it has been successfully activated. To 
restart activation after you have cancelled, just disconnect your device from your 
computer and then attach it again.

● One-Touch Activation — Sprint SmartView will display a pop-up window that indicates 
that your device requires activation/programming and asks you if you would like to 
activate/program the device now. Click the Yes button on the pop-up to activate your 
device.
If you choose to cancel activation at this time (by clicking No), you can restart activation 
by disconnecting it from your computer and then attaching it again. One-Touch Activation 
can also be restarted by selecting Activate Device from the Tools Menu. See “Device 
Property Window: CDMA Version” on page 141 for more information.

● Activation Wizard — For some devices, Sprint SmartView will display an “Activation 
Wizard” when the device is connected. Although such devices require a few more steps 
to activate than those that use the techniques mentioned above, the wizard provides 
clear, step-by-step instructions to guide you through the process. 
Although you have the option to cancel the activation process at any time, you will not be 
able to use the device for data connections until it has been successfully activated. To 
9        Section 1D. Launching Sprint SmartView
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restart activation after you have cancelled, just disconnect your device from your 
computer and then attach it again.

The Activation Wizard is accessible from the Tools menu by selecting Activate 
Device. At anytime there are problems with your connection, or for new service, you 
can go through this wizard. You may need a Social Security Number, Tax ID Number, 
Billing Address, and/or Driver's License Number. 

Use the following Activation Wizard tutorial to assist you in activating your device.

Activation Wizard Tutorial

This tutorial is designed to assist you in activating your Mobile Broadband device. Follow 
these steps to use the Activation Wizard. 

1. Connect your device to your computer by using either a USB cable or inserting the 
device into a PC Card or Express Card slot, whichever is applicable.

2. Open the Sprint SmartView application.

3. Select Activate Device from the Tools menu in the SmartView main window. The 
Activation Wizard window as shown below will open.

4. Read the text in the Activation Wizard window and collect the required personal 
information according to the instructions in the window.

Note This procedure can only be used to activate devices that employ the Activation 
Wizard. It cannot be used to activate devices that employ one touch activation or 
hands free activation techniques.
Section 1E. Device Activation        10



5. Click Next to proceed to the next page of the Activation Wizard.

6. Follow the instructions in this window for entering your Activation Code (or MSL).

7. On a piece of paper, write down the Electronic Serial Number (ESN) shown on this page 
of the wizard.

8. Click Next to proceed to the next page of the wizard. 

9. This window tells you that your Activation Code has been accepted, and tells you to enter 
the Phone Number (MDM) and the MSID (IMSI_S) that the Customer Solutions 
Representative gave you.
11        Section 1E. Device Activation
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10. When you have entered the Phone Number and MSID in the text boxes provided in 
the window, click the Next button. The Activation Wizard will display the Confirmation 
dialog shown below.

11. Verify that the numbers you entered in the previous window are the numbers that 
appear in this Confirmation dialog.

� If the numbers are correct, click the Yes button. The next page of the Activation 
Wizard will appear. Proceed to Step 12.

� If the numbers are not correct, click the No button. The Activation Wizard will take 
you back to the previous window so you can correct your entries. 

12. The final page of the Activation Wizard informs you that it will take approximately four 
hours to activate your device.
Section 1E. Device Activation        12



Since the Finish button will be disabled until network services are available, leave your 
computer ON and the Activation Wizard open until the Finish button is enabled (black 
border and text, not gray border and text).

13. When the Finish button is enabled, click it to close the Activation Wizard.
13        Section 1E. Device Activation
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Section 1F

Getting Help

This section describes where you can find more information on Sprint services, options, 
and troubleshooting problems you have encountered.

Visiting the Sprint Web Site

Stop by www.sprint.com and log on to get up-to-date information on Sprint services, 
options, and more.

You can also:

●  Review coverage maps.

●  Access your account information.

●  Add additional options to your service plan.
●  Purchase accessories.

●  Check out frequently asked questions.

●  And more.

Contacting Sprint Customer Service

You can reach Sprint Customer Service by:

● Logging on to your account at www.sprint.com.

● Calling us toll-free at 1-800-SPRINT1 (personal use) or 1-800-927-2199 (business 
use).

Troubleshooting

The Online Help for Sprint SmartView (select Help from the Help Menu) includes 
descriptions of most common error messages. Look in the Table of Contents under 
Troubleshooting. Additionally, you’ll find that most of the content in this guide also appears 
in the Help System.

For help with other problems:

● Chapter 15, “Troubleshooting Tools” in this guide describes a number of 
informational tools included in Sprint SmartView that may be of help in diagnosing 
problems.

● Chapter 16, “Troubleshooting Procedures” describes techniques that can be used to 
resolve the most common problems.

Contact Sprint as noted above.
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Section 2A

New vs. Classic Interface

This release of the Sprint SmartView software contains an exciting new version of the software’s 
main window. This version is designed to put the maximum functionality at your fingertips 
quickly and easily.

If you prefer the classic interface, you can choose this option when you install the software. 

Whichever interface you choose, however, the Sprint SmartView software provides the same 
powerful set of connectivity options.

Switching Interfaces

You can change from one version of the interface to another after installation is complete.

1. Select Load Skin from the Tools menu. The Skin Browser window appears. This window 
will list two different skins:

� Sprint.skx — The classic interface.

� SprintSV.skx — The new interface.

2. In the Thumbnails column, select the interface that you wish to use.

3. Click OK.
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Section 2B

The New Interface

Connection Control Buttons
Click these buttons to connect to a network of the desired type. When connected, the 
button will turn yellow. Click again to disconnect. See “Connection Control Buttons: In 
Detail” on page 20 for more information.

Network Availability Indicators
When lit, these small green icons indicate that a network of the corresponding type is 
available. For wireless technology types, the icon is also indicates the signal strength of the 
available network.

GPS Privacy Indicator
This icon appears when a Mobile Broadband device that supports GPS has been attached. 
When no such device is present, the icon does not appear. 

If a red slash appears across this graphic, a device that supports GPS is present, but its 
GPS functions are disabled. This is also called “privacy mode” because the device is not 
exchanging information about your location with the network. To exit privacy mode and 
enable GPS functions, uncheck the Disable GPS on Device box on the Location/GPS tab of 
the settings window (see page147).

VPN Indicator
Click this icon to log on to a Virtual Private Network (VPN) using the settings configured on 
the VPN tab of the settings window. The indicator will turn orange and spin while your VPN 
client software is being launched. It will turn yellow upon successful connection to the 
desired VPN.

Connection Control
Buttons

Privacy
Indicator

VPN
Indicator GPS

Indicator

Network Availability
Indicators

Connection
Status

GPS
Search Menu

Application
Launch Menu

My Networks
Button

Automatic Mode
Indicator
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GPS Indicator
This icon will be lit (yellow) when GPS functions are enabled on your Mobile Broadband Device. 
(Use the Disable GPS on Device box on the Location/GPS tab of the settings window to enable 
and disable GPS functionality. [see page 147])

Click this icon to open the GPS Applications Menu (see page 93). Hover over it to view the data 
received from your GPS device. 

Automatic Mode Indicator
Normally, the Sprint SmartView software will automatically establish a connection using the 
Network Profile with the highest priority. However, it switches to manual connection mode when 
you manually choose a network to connect to.

This indicator lights up to indicate the Sprint SmartView software is in automatic connection 
mode. The indicator dims when in manual mode. However, you may return to automatic mode 
by clicking here. See “Automatic vs. Manual Connection” on page 32 for more information.

Connection Status
This area displays Connection Status information for the current connection technology. See 
“Connection Status: In Detail” on page 21 for more information.

My Networks Button
Click this button if you would like to manually select a network to connect to. This produces a 
list of all networks that are available for connection. They are listed in the following order:

1. Networks for which a profile has been created, in order of priority.

2. WiFi networks for which you do not currently have a profile.

GPS Search Menu
If your Mobile Broadband Device supports GPS functionality, you can search for nearby 
restaurants, hotels and other amenities using this menu. To perform a search, just type what you 
are searching for in the space provided or select one of the pre-defined searches from the 
menu. See “The GPS Search Menu (New Interface)” on page 92 for more information.

Application Launch Menu
Quickly launch commonly-used applications by selecting a desired application from this menu. 
Additional applications can be added to this list using the App Launcher tab of the settings 
window. See “Launching External Applications” on page 77 for more information.

Note This icon will not appear if your Mobile Broadband Device does not contain a 
supported GPS receiver. Currently, the Sprint SmartView software does not support 
GPS receivers in phone handset devices.
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Connection Control Buttons: In Detail

This row of buttons represents various connection technologies (Mobile Broadband, WiFi, 
etc). Depending on the version of the Sprint SmartView software installed and which 
devices you currently have connected to your computer, you may have up to five such 
buttons:

Connection State
The connection state for each technology is indicated by the coloration of the 
corresponding button.

Extended connection status information for a particular technology can be obtained either 
by hovering over the Connection Control button or by clicking the technology name below 
the button.

WiMAX Ethernet 

Mobile Broadband Dialup

WiFi 

Connected. Sprint SmartView is currently connected using this technology. 
Click this button to disconnect. 

Ready. Sprint SmartView is ready to establish a connection using this 
technology. Click to establish a connection using this technology. 

No Network Available. If the button is dimmed, A device of this type is 
installed in your computer, but no network of this type is currently available. 

no button
displayed

Not Installed. If no button is displayed, you don't have a device of this type 
connected to your computer or this technology type is not supported by 
your version of the Sprint SmartView software.
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Selecting Alternate Networks
Click the arrow ( ) beneath any of the connection control buttons to display a list of all 
networks that are currently available for that technology. Selecting any item in this list will initiate 
a connection to the corresponding network.

Connection Status: In Detail

The area on the right side of the main window displays connection status information for the 
connection technology indicated by the technology type icon.

You can cause this area display status information for a different technology by clicking the 
NAME of the desired connection technology on the left side of the window. The name you 
clicked will become highlighted to indicate that status is being displayed for that technology.

Connection Status Text
A brief textual description of the connection status for the currently-selected network (fro 
example, “Ready to Connect” or “Connected”). This also usually includes the name of the 
current network. However, some states (such as “No Device Detected”) are not network-specific.

Technology Type
This icon indicates the technology employed by the selected network:

WiMAX

Mobile Broadband 

WiFi 

Ethernet 

Dialup 

Connection
Status

Technology
Type

Roaming
Indicator

Connection
Timer

Signal Strength
(WiFi, Mobile and WiMAX only)

Connection Technology
Indicator
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Signal Strength
This gauge shows the strength of the signal being broadcast from the currently-selected 
network. Stronger signals tend to produce more reliable connections.

Connection Technology Indicator
This indicates the specific data technology which is employed by the network.

Roaming Indicator
This icon appears for Mobile Broadband connections if the currently-selected network is a 
roaming network. In other words, you will be roaming off the Sprint network if you connect 
to this one. Consult your wireless service plan for more information about roaming.

Connection Timer
This timer indicates how long you have been connected to the currently-selected network. 
The timer only appears when you are currently connected via the selected technology type.

Note The timer can be turned off completely (hidden always) by unchecking the Display 
Connection Timer box on the Client settings tab.
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Section 2C

The Classic Interface

The classic interface uses a tab for each type of connection (Mobile Broadband and WiFi). Just 
click the appropriate tab to view the connections interface for the corresponding technology 
type. 

Interface Selection Tabs
Click the tabs at the top of the interface to switch between the Mobile Broadband, WiFi and 
WiMAX connection interfaces.

Each tab includes a connection status indicator; its color indicates the current connection state 
of the corresponding technology: 

● Green when you are currently connected
● Yellow when you are not connected (but your device is available)

● Black when your device is disabled or not available.

Connect/Disconnect Button
Click the Connect button to establish a connection using the wireless technology whose tab is 
currently selected. Click this button again to disconnect. See Chapter 3, “Mobile Broadband 
Connections” and Chapter 7, “Connecting to WiFi Networks” for more information on 
establishing connections.

Note Although some versions of the Sprint SmartView software support the Ethernet and 
dialup functions described in sections 8 and 9, the “classic” interface does not 
support these functions in the main window. If you are using the “classic” interface, 
Ethernet and dialup connections must be established in the Network Profiles 
window (see “The Network Profiles Window” on page 110).

Click Here
to Connect or
Disconnect

Click this tab to display
the Main Window

for Wi-Fi Connections

Click this tab to display
the Main Window

for WiMAX Connections

Click this tab to display
the Main Window for Mobile

Broadband Connections

Connection
Status
Indicator
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Status Text
Connection status for the currently-selected technology (for example, “Ready to Connect” 
or “Connected”). This also usually includes the name of the current network. However, 
some states (such as “No Device Detected”) are not network-specific.

Applications Button
Click the Applications button to display the Application Bar. Click again to hide it. The 
Application Bar is used to quickly launch commonly used applications. See “The 
Application Launcher” on page 76 for more information.

GPS Button
If your Mobile Broadband device contains a GPS receiver, you can click the GPS button to 
display the GPS Bar. Click again to hide it. The GPS bar is used to view global positioning 
data and to use location-based services. See “Using GPS” on page 88 for more 
information.

VPN Button
Click the VPN button to log into a Virtual Private Network (VPN). See “Virtual Private 
Networks (VPNs)” on page 104 for more information.

Note This button will not be visible if your Mobile Broadband device does not have GPS 
capability. Currently, the Sprint SmartView software does not support the GPS 
cababilities in phone handset devices attached to your computer. You will need a 
dedicated data card for this function.

Display
Application Bar

Display
GPS Bar

Launch a VPN
Connection

Status Text
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GPS Privacy Indicator
This icon appears when a Mobile Broadband device that supports GPS has been attached. 
When no such device is present, the icon does not appear.

If a red slash appears across this graphic, a device that supports GPS is present, but disabled. 
This is also called “privacy mode,” because the device is not exchanging information about 
your location with the network. To exit privacy mode and employ the device for Location 
Services, just open the GPS Bar. 

Connection Timer
This timer indicates how long you have been connected to the current network. The timer only 
appears when you are currently connected to a network of this technology type.

Signal Strength Indicator
This gauge shows the strength of the signal being broadcast from the currently-selected 
network. Stronger signals tend to produce more reliable connections.

Note The Connection Timer can be turned off completely (hidden always) by removing the 
check from the Display Connection Timer box on the Client Tab in the Settings 
window (see page 137).

Signal Strength
Indicator

Connection
Timer

GPS Privacy
Indicator
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Mobile Broadband-Specific Items

In addition to the standard items, the Mobile Broadband Connections Interface contains the 
following:

Roaming Indicator
On the Mobile Broadband Connections Interface, this triangular icon appears when the 
current connection is off the Sprint Network. Consult your wireless service plan for more 
information about roaming.

Connect Using Button
This button is not available unless you are using a GSM Device (it’s normally hidden). If the 
button does appear on this interface, it is labeled “Connect Using.” Clicking it produces a 
menu which allows you to select the Mobile Broadband Network Profile that you would like 
to use to establish connections.

Amount of Data Transferred
On the Mobile Broadband Connections Interface, these values indicate the total amount of 
data which has been sent ( ) and received ( ) by Sprint SmartView over the current 
connection. The third value (which displays both arrows) is simply the total for both 
directions.

These indicators only appear when you are currently connected to a network of the 
corresponding technology type.

Connection Technology Indicator
This indicates which Mobile Broadband data technology is used for the current connection.

Connection Technology

Roaming
Indicator

Connect Using Button

Amount of Data Transferred
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WiFi-Specific Items

In addition to the standard items, the WiFi Connections Interface contains the following:

Networks Button
Click it to open the list of all WiFi Networks detected by Sprint SmartView. See “Available WiFi 
Networks (Classic Interface)” on page 57 for more information.

Data Transfer Rate
The first two values represent the rate at which data is currently being sent ( ) and received 
( ) by Sprint SmartView over the WiFi connection. These indicators only appear when you are 
currently connected to a network of the corresponding technology type.

WiFi Protocol Indicator
This indicator displays the WiFi protocol used by a network you are currently connected to. 
There are three different protocols:

● 802.11a - provides over the air transmission speeds of up to 54 Mbps in the 5 GHz 
frequency band.

● 802.11b - provides over the air transmission speeds of up to 11 Mbps in the 2.4 GHz 
frequency band.

● 802.22g - provides over the air transmission speeds of more than 20 Mbps in the 2.4 
Ghz frequency band.

Encryption Indicator
This indicates whether the current WiFi connection uses encryption technologies to maintain 
network security. If encryption is used, the type of encryption will be displayed here. If no 
encryption is used, this indicator will not be displayed.

Encryption
Indicator

Networks Button

Data Transfer Rate

WiFi Protocol Indicator
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WiMAX-Specific Items

In addition to the standard items, the WiMAX Connections Interface contains the following:

CINR
Carrier to Interference + Noise Ratio. This is an indication of how strong the desired signal 
is compared to any interfering signals and noise.

Received Signal Strength
The strength of the received signal is displayed as both a value in dBm and as the familiar 
signal strength bar graphic.

Center Frequency
The center frequency used by your current WiMAX connection.

TXPWR
The level of power currently being used for transmissions by your WiMAX device.

Transmit
Power

CINR
(graphic)

Received Signal
Strength (graphic)

Received Signal
Strength (dBm)

Center
Frequency

CINR (dBm)
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Controls for the Classic Main Window

In the classic interface, the buttons in the upper-right corner of the main window control the 
appearance and location of the window.

Click this button to convert the window to a miniature toolbar version of itself 
like the window below.

Click this button (which only appears on the mini toolbar version of the Main 
Window) to restore the window to full size.

Click this button (which only appears on the mini toolbar version of the Main 
Window) to display a menu which combines options from the File, Tools, and 
the Help Menus of the full-sized window.

Click this button to reduce the window to a button on the Task Bar at the 
bottom of the screen.

Click this button to close the window.
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Section 2D

Menus in the Main Window

The File Menu

Clicking File in the Menu Bar of Sprint SmartView's Main Window produces a short menu 
with the following options:

● Enabling and Disabling Adapters — An Enable/Disable option will be listed for each 
adapter type supported by this version of SmartView. Disabling adapters is useful 
when you want to prevent an adapter from establishing connections or when you 
want to keep it from consuming your laptop's power. For wireless adapters, this also 
prevents interference with other wireless transmissions (you may be asked to turn off 
wireless adapters on an airplane, for example).

● Airplane Mode — Selecting this item disables all adapters. An airplane icon will 
appear in the main window to indicate that airplane mode has been engaged. Click 
this icon or select the menu item a second time to return to normal operation. 

● Exit — Exit the Sprint SmartView Application.

The Tools Menu

Clicking Tools in the Menu Bar of Sprint SmartView's Main Window produces a menu with 
the following options:

● Profiles — Select this option to display the network Profiles window (see page 110). 
This window is used to create and edit network profiles. It is also used to set their 
priority.

● Sprint WiFi Login — Select this item to open the Username and Password Logon 
window. This window can be used to enter a single standard User Name and 
Password combination that will be used as a default for all WiFi and Dialup 
connections. See page 34.

● WiFi Info — Select this item to open the WiFi Network Properties window. This 
window displays some technical information about the WiFi Network you are 
connected to and your current WiFi device. See “WiFi Network Info” on page 156.

● Mobile Info — Select this item to open the Mobile Info window. This window displays 
some technical information about the Mobile Network you are connected to and your 
current Mobile Broadband Device. See “The Mobile Info Window” on page 159.

Note WiFi-related items will not appear in this menu if you have disabled SmartView’s WiFi 
Support. To re-enable WiFi Functions, check the Use this as my default WiFi 
management utility box on the Client Tab of the Settings Window (see page 137).
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● WiMAX Info — Select this item to open the WiMAX Info window. This window displays 
some technical information about the WiMAX network you are connected to and your 
current WiMAX device. See “The WiMAX Info Window” on page 163.

● Ethernet Info — Select this item to open the Ethernet Info window. This window displays 
some technical information about the Ethernet network you are connected to and your 
current Ethernet device. See “The Ethernet Info Window” on page 167. 

● Lock Device/Unlock Device — Select this option to lock and unlock your Mobile 
Broadband Device. See “Locking and Unlocking Your Mobile Broadband Device” on 
page 40 for more information.

● Update Data Profile (IOTA) — Selecting this item instructs your Mobile Device to update 
its provisioning information so that it may properly use Sprint Data Services.

● Activate Device — Select this item to activate your Mobile Broadband Device.
● Check for Application Updates Now — Selecting this item forces Sprint SmartView to 

check for updates to its software and its databases immediately.

● Load Skin — Select this interface to open the Skin Browser window. This window allows 
you to choose whether you would like to use the classic interface or the new interface.

● Settings — Select this item to open the Settings window. The Settings window allows you 
to configure a number of personal preference features. This window is covered in detail in 
Chapter 14, “Sprint SmartView Settings.”

The Help Menu

Clicking Help in the Menu Bar of the Sprint SmartView's Main Window produces a short menu 
with the following options:

● Help — Opens the Sprint SmartView’s Help System. 
● Event Manager History — Select this option to display a list of the most recent Sprint 

SmartView Events (network connections, network disconnection, errors, etc.) See “Event 
History Manager” on page 155 for more information.

● About Sprint SmartView — Select this option to display a window displaying version 
information for the Sprint SmartView software. See page 170.

Note This item only appears on versions of the Sprint SmartView software that support 
Ethernet connections. 
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Section 2E

Automatic vs. Manual Connection

By default, Sprint SmartView will automatically select an available network to connect to 
based on the priorities specified in the Network Profiles window. See “Network Profile 
Priority” on page 110 for a discussion of how this works.

However, you can also manually select a network with which to establish a connection.

Manually Establishing Connections in the “New” Interface

If you are using the “new” interface, you can manually establish a connection by doing any 
of the following.

● Click one of the Connection Control Buttons in the main window to establish a 
connection using the technology the button depicts.

● Click the arrow ( ) beneath any of the connection control button. Then, select a 
network profile from the menu that appears.

● Select a network profile from the menu that appears when you click the My Networks 
button (this menu lists ALL available network profiles).

● Select a network profile from the list in the Network Profiles window and then click 
the Connect button.

See the “Manually Connecting....” topics in the sections dedicated to particular connection 
technologies for more information on establishing manual connections.

Manually Establishing Connections in the “Classic” Interface

If you are using the classic interface, you can manually establish a connection by doing 
either one of the following:

● Select the appropriate connection technology tab and then click the Connect button 
in the main window.

● Select a network profile from the list in the Network Profiles window and then click 
the Connect button in the same window.

See the “Manually Connecting....” topics in the sections dedicated to particular connection 
technologies for more information on establishing manual connections.
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Returning to Automatic Mode

Manually connecting to a network will disable automatic connection. 

If you are using the new interface, the Automatic button will dim to indicate that automatic 
connection has been disabled and Sprint SmartView will no longer establish connections 
automatically. However, you can return to automatic mode by clicking the Automatic button.

If you are using the classic interface, you must exit the Sprint SmartView software and then start 
it again to return to automatic mode.
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Section 2F

Username and Password Logon Window

Selecting Sprint WiFi Login... from the Tools menu causes the Username and Password 
Logon Window to appear.

1. Enter your User Name in the Username box.

2. Enter your Password in the Password box.

3. Again, enter your Password in the Confirm Password box.

4. Choose the Save option that best suits your needs:

� Save Nothing

� Save Username only

� Save Username and Password

5. Click OK to save your entries and close the window, or click Cancel to discard your 
entries and close the window.
Section 2F, Username and Password Logon Window        34



35        Section 2F, Username and Password Logon Window



Section 3

Mobile Broadband
Connections



Section 3A

Manually Connecting to a Mobile Broadband Network

Before you begin, you will need the following:

● A CDMA or a GSM Mobile Broadband device that you will use to establish connections. 
Windows device drivers for this device must be properly installed according to the 
manufacturer's instructions and the device must be selected in the Hardware tab of 
Sprint SmartView's Settings window.

● A valid Mobile Broadband User Account.

● A network profile configured to access the Sprint Network (this is created for you 
automatically when you connect a supported Mobile Broadband device).

Using the New Interface

To connect to a Mobile Broadband Network in Sprint SmartView's new user interface, follow 
these steps:

1. Ensure that your Mobile Broadband device is properly configured and connected to your 
computer. Sprint SmartView will begin searching for an available network. When Sprint 
SmartView is ready, the Mobile button will display the Ready state (see “Connection State” 
on page 20).

2. Click the Mobile button.

Note If you are using a GSM Mobile Broadband Device for international roaming, 
clicking the arrow ( ) beneath the Mobile button produces a menu listing all 
GSM network profiles. You can establish a connection using any profile listed 
simply by selecting it from the menu. The default (“Sprint”) profile, however, should 
be used when connecting to any of Sprint’s roaming partners. See Chapter 5, 
“International Roaming (GSM)” for more information about roaming internationally.
37        Section 3A, Manually Connecting to a Mobile Broadband Network



M
ob

ile
 B

ro
ad

ba
nd
Using the Classic Interface

To connect to a Mobile Broadband Network in Sprint SmartView's classic user interface, 
follow these steps:

1. Click the Mobile Broadband tab in the Sprint SmartView main window. If your device 
is properly connected and configured, Sprint SmartView will begin searching for an 
available network. When Sprint SmartView is ready, it will display “Ready to Connect.

2. Click the Connect button.

Note If you have a GSM Mobile Broadband device for international roaming and you 
have more than one GSM network profile, a Connect Using button will appear 
above the Connect button. Clicking this button produces a menu listing all 
GSM network profiles. You can establish a connection using any profile listed 
by selecting it form the menu and then clicking Connect. The default (“Sprint”) 
profile, however, should be used when connecting to any of Sprint’s Roaming 
partners. See Chapter 5, “International Roaming (GSM)” for more information 
about roaming internationally.
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Section 3B

Automatic Connection for NDIS Devices

When a Mobile Broadband device is in NDIS mode, it can be configured to establish a 
connection automatically whenever you attach it to your computer. 

1. Make sure your device is in NDIS mode. 

a. Open the Hardware tab of the Settings window.

b. Scan down the device list to find the device that you want to connect automatically. 
When you find the device, click the button in the Property column of the same line. 
The CDMA Device Properties window appears.

c. Ensure that NDIS is selected in the “Connection Type” section.

d. Click OK to exit the CDMA Device Properties window.

e. Click OK to exit the Settings window.

2. Establish a Mobile Broadband connection using Sprint SmartView.

3. Without disconnecting, exit the Sprint SmartView software.

4. Sprint SmartView will ask you to confirm that you wish to remain connected. Remain 
connected to be placed in auto-connect mode.

Your Mobile Broadband device should now automatically establish a connection each time you 
connect it to your computer — even if Sprint SmartView is not currently running. Although it is 
not necessary to open Sprint SmartView to use such a connection, if you choose to do so, 
Sprint SmartView will be able to control the connection normally.

Note Not all Mobile Broadband devices support NDIS mode. If this is the case with your 
device, you will not be able to select NDIS in the Mobile Device Property Window.
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Section 3C

Locking and Unlocking Your Mobile Broadband Device

You can lock your Mobile Broadband device to prevent it from being used by unauthorized 
individuals. A locked device cannot be used to establish a connection until it has been. 
unlocked.

Locking the Device

1. Select Lock Device from the Tools menu. The Enter Lock Code window appears. 

2. Enter the current Lock Code in the space provided. 

3. Click OK to lock the device.

Unlocking the Device

1. Select Unlock Device from the Tools menu. The Enter Lock Code window appears. 

2. Enter the current Lock Code in the space provided.

3. Click OK to unlock the device.

Note The default lock code is the last four digits of the device’s phone number, 
which can be found by selecting Mobile Info from the Tools menu (it’s the 
second item under User Information on the Device tab).
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Section 4A

What You Need

In order to use a phone as a Mobile Broadband device, you will need the following:

● A Phone as Modem compatible handset. For a list of supported handsets, please see 
Sprint.com/downloads > Sprint Smartview.

● You must have “Phone as Modem” enabled in your account. Contact Sprint Customer 
care for an appropriate Phone as Modem plan.

Section 4B

Establishing Connections

To establish a connection using your phone as a modem, use the procedures described in 
Section 3, “Mobile Broadband Connections.” However, the following phone-specific guidelines 
apply:

● To connect your phone to your computer, attach one end of a USB cable to your phone 
and the other end to one of your computer’s USB ports.

● If you receive a connection-related error, looking at the phone’s screen may give you 
additional information about the error that occurred. If the error displayed on the device is 
error 76, you don't have Phone as Modem enabled on your account. Contact Sprint 
Customer Care for an appropriate Phone as Modem Plan.

Note Most handsets require that you enable wireless modem mode for your phone’s 
USB interface. Please refer to your Quick Start Guide for information on enabling 
this function.
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Section 5A

Overview

In most cases, you can connect to Sprint’s roaming partner networks around the world using 
the same simple, one-click access employed for domestic connections. 

Section 5B

Selecting CDMA or GSM on a Dual-Mode Device

If you have a dual-mode CDMA/GSM device, you must select the mode you want to use.

1. Select CDMA or GSM mode according to the instructions that came with your device.

2. Force Sprint SmartView to learn what type of device you’re using. This happens 
automatically whenever you start the Sprint SmartView Application. If Sprint SmartView is 
already running, you can do any one of the following:

� Connect the device to your computer (if not currently connected)

� Disconnect and re-connect your device (if already connected)

� Exit and restart the Sprint SmartView application.

Section 5C

Switching Between a CDMA Device and a GSM Device

If you have both a GSM device and a CDMA device attached to your computer, you can select 
which device you would like to use by doing the following:

1. Open the Settings window by selecting the Settings option in the Tools menu.

2. Select the Hardware Tab. 

3. Scan down the list until you locate the Mobile Devices heading. To the right of this 
heading (in the Selected column) is a pull down menu. Select Manual from this menu 
(this enables manual selection of your Mobile Broadband device). 

4. Check the box next to the device you wish to use.

5. Click the OK button to exit the window.
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Section 5D

Establishing an International Roaming Connection

Once you have attached a GSM Mobile Broadband device (or a dual-mode device in GSM 
mode), the Sprint SmartView Software will search for an available roaming network and 
configure itself to connect to that network as needed. When it’s finished, the status text on 
the Main Window will inform you that Sprint is ready to connect, just as it does for domestic 
connections.

Just click the Mobile icon in the main window (new interface) or the Connect button (classic 
interface), and you’re done.

Section 5E

Manually Selecting a GSM Roaming Network

If you wish to override Sprint SmartView’s choice of a network to connect to, you can do so 
by following these steps:

1. Go to www.sprintpcs.com/common/popups/pop-gprsCarriers.html, where you’ll find a 
list of Sprint’s roaming partners that provide data services.

2. Make note of the carriers that provide data services supported by your device in the 
area to which you are traveling.

3. Connect your GSM Mobile Broadband device to your computer.

4. If the device is a dual mode device, make sure the device is in GSM mode.

5. Start the Sprint SmartView software.

6. Open the Settings window by selecting the Settings option in the Tools menu.
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7. Select the Hardware tab.

8. Scan down the list of installed devices until you find the Mobile Devices heading. Click 

 directly to the right of this heading. The GSM Device Properties window 
appears.

9. Select Manual in the Network Selection box.

10. Click the Scan Button. A list of all GSM Networks detected appears in the table.

11. Click to highlight the Operator Name or the Operator ID of the desired operator to select 
the network you wish to connect to (use one of the operators you chose in step 2).

12. Click OK to exit the window.

Note In some cases, the same operator may provide multiple data services, all of 
which look the same in this list (such as the “Orange” listing in the image on 
the previous page). Unfortunately, there’s no easy way to tell them apart. The 
only way to do so is to simply try connecting to one. If it’s not the one you 
wanted, try another (the services will always appear in the same order in this 
window). 
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Section 5F

Creating a GSM Network Profile

Creating a GSM profile should rarely, if ever, be necessary. Whenever you connect a GSM 
device, Sprint SmartView creates a GSM network profile for you automatically. The 
automatically-generated profile can be used to connect to any of Sprint’s roaming partner 
networks. 

There are two types of manually-created GSM profiles:

● Sprint Profiles are just slightly customized profiles based on Sprint’s default GSM 
profile. Such a profile inherits Sprint’s GSM connection settings, but allows you to 
customize TCP/IP settings (see page 127) and General profile settings (see page 
132). At this time, Sprint doesn’t know of any specific situation in which this is 
required. However, the capacity to create such a profile is provided just in case 
Sprint’s Technical Support staff needs to solve some connection problem for you, by 
helping you manually alter your connection settings.

● Custom Profiles are entirely new profiles, unrelated to the Sprint GSM profile. 
Creating such a profile would be required if a non-Sprint SIM is placed in the device.

Follow these steps to create a GSM network profile:

1. Select Profiles from the Tools menu. The Network Profiles window will now be 
displayed.

2. Select Add New Profile from the Settings menu. A list of network profile types now 
appears.

3. Select GPRS. 

4. Click Add. The first page of the Add Profile Wizard appears. This page prompts to 
choose one of the two profile types.

5. Select either Sprint or Create Custom Profile and then click the Next button. The 
GPRS page of the New Profile Wizard appears (see page 125).

6. If you selected Sprint on the previous page, the correct settings for the GPRS page 
will be pre-populated and you can’t change them here.

If you selected Create Custom Profile, enter the correct settings for connecting to the 
desired GSM network.

7. Click the Next Button. The IP Settings page appears (see page 127).

8. The default selections in the IP Settings page are correct for most GSM networks. If, 
however, this particular network requires a specific IP Address and/or DNS Server 
Settings, you can specify them here.

IMPORTANT Sprint does NOT support the use of non-Sprint SIMs. If you choose to do 
so, it is entirely your responsibility to obtain the correct connection 
information from the provider of the SIM and enter it correctly into the 
Network Profile Wizard.
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9. Click the Next button. The General page appears (see page 132).

10. The settings in the General page are largely personal preference (for example, do you 
want to launch you browser upon successful connection?). Configure these as desired.

11. Click Finish.

Section 5G

International Technical Support

If you need technical support when roaming internationally, you can dial the following numbers 
either from your Sprint phone or via land line.

● While in the United States:

Call 1-888-226-7212, option 2. (This will be a free call.)

● While traveling outside of the United States:

Call: +1-817-698-4199, option 2. (Access or connection fees may apply.) 

Support Numbers for Specific Countries
The toll-free numbers below can also be used to contact Customer Solutions from a land line 
phone in the following countries. Dial the desired number and choose Option 2.

● Anguilla 1-888-226-7212 

● Barbados 1-888-226-7212 

● Cayman Islands 1-888-226-7212 
● China 00-1-800-713-0750 

● Dominica 1-888-226-7212 

● France 0800-903200 
● Germany 0800-180-0951

● Italy 800-787-986

● Trinidad & Tobago 1-800-207-7545
● United Kingdom 0808-234-6616 
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Section 6A

Manually Connecting to a WiMAX Network

Before you begin, you will need the following:

● A WiMAX device that you will use to establish connections. Windows device drivers for 
this device must be properly installed according to the manufacturer's instructions and 
the device must be selected in the Hardware tab of Sprint SmartView's Settings window.

● A valid WiMAX User Account.

● A WiMAX network profile for the network you wish to access.

Using the New Interface

To connect to a WiMAX network in Sprint SmartView's new user interface, follow these steps:

1. Ensure that your WiMAX device is properly configured and connected to your computer. 
Sprint SmartView will begin searching for an available network. When Sprint SmartView is 
ready, the WiMAX button will display the Ready state (see “Connection State” on 
page 20).

2. Click the WiMAX button.

Using the Classic Interface

To connect to a WiMAX network in Sprint SmartView's classic user interface, follow these steps:

1. Click the WiMAX tab in the Sprint SmartView main window. If your device is properly 
connected and configured, Sprint SmartView will begin searching for an available 
network. When Sprint SmartView is ready, it will display “Ready to Connect.

2. Click the Connect button.

Note If you have more than one WiMAX network profile, clicking the arrow ( ) 
beneath the WiMAX button produces a menu listing all WiMAX network profiles. 
You can establish a connection using any profile listed simply by selecting it from 
the menu.
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Section 7A

Manually Connecting to a WiFi Network

Using the New Interface

Follow these steps to manually connect to a WiFi network in the new interface:

1. If you have not already done so, connect your WiFi device to your computer. If your device 
is properly connected and configured, Sprint SmartView will begin searching for an 
available network. When Sprint SmartView is ready, the WiFi button will display the Ready 
state (see “Connection State” on page 20).

2. To connect to the network Sprint SmartView has selected, click the WiFi button to begin 
the connection process.

— or —

Click the arrow ( ) beneath the WiFi button. This button produces a list of all available 
WiFi network profiles. You can establish a connection using any profile listed simply by 
selecting it from the list.

Using the Classic Interface

Follow these steps to manually connect to a WiFi network in the “classic” interface:

1. If you have not already done so, connect your WiFi device to your computer.

2. Click the WiFi tab in Sprint SmartView’s main window. If there are available WiFi networks, 
Sprint SmartView will select a network to connect to and display its name.

3. To connect to the selected network, click Connect.

— or —

To connect to a different network, click the Networks button. This produces a list of all 
available networks (see page 57). Select the network you want to connect to by clicking 
once on the associated Connect button or by double-clicking anywhere else within the 
same row.

Tip Hover over the WiFi button if you want to see details about the network Sprint 
SmartView has selected.

Note A *closed* item in the networks list indicates the presence of one or more 
closed networks. See “Accessing a Closed Network” on page 61 for more 
information.
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Prompts

Once you have completed one of the above procedures, Sprint SmartView will attempt to 
establish a connection to the selected network. You may see either one or both of the 
following prompts during this process:

● If the network is encrypted, you will be prompted to enter an encryption key. If this is 
the case and you know the required encryption key, enter it and click OK. If you don't 
know the encryption key for an encrypted network, you must click Cancel and select 
a different network. See “Introduction to WiFi Encryption” on page 62 for more 
information on connecting to encrypted networks.

● When you connect to a WiFi network for the first time, Sprint SmartView may display 
the New Network Options prompt (see page 55). Using this dialog box, you can 
configure Sprint SmartView to automatically connect to a network in the future or to 
prompt you when that network is available.
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Section 7B

Options for Connecting to a New Network

If Prompt me before saving network settings is selected in the Automatic Profile Creation 
Settings Window (see “Automatic Profile Creation Settings” on page 118), you will see the 
dialog pictured below whenever you connect to a new WiFi Network for the first time. The 
option selected specifies the type of profile that Sprint SmartView will create for this network. By 
creating a profile automatically, Sprint SmartView makes it easier for you to connect to the same 
network in the future.

You must choose one the following options:

Automatically connect to network in future
If this option is selected, the profile created will specify that Sprint SmartView should 
automatically establish a connection to this network whenever it is detected.

Prompt me before connecting to this network
If this option is selected, the profile created will specify that Sprint SmartView should offer to 
connect to this network whenever this network is detected.

Save settings for manual connections
If this option is selected, the profile created will save the settings you used to connect to this 
network. This allows the Sprint SmartView to automate the details of establishing a connection 
to this network. However, you must still initiate connections to this network manually by 
selecting the network and then clicking the Connect button.

Note When multiple networks that have been configured for auto-connection are 
detected, Sprint SmartView will choose which network to connect to based on the 
ranking of profiles in the Network Profiles window.
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Do not save settings
Choosing this option will allow you to connect to the network this time, but will not save any 
parameters for future connections (no profile will be created).
Section 7B, Options for Connecting to a New Network        56



Section 7C

Available WiFi Networks (Classic Interface)

If you are using Sprint SmartView’s classic interface, clicking the Networks button in the WiFi 
Main Window opens the list of all WiFi networks that are currently detected by Sprint SmartView.

● Click Rescan to update the list 
● Click Reset to clear the list

● Click a Connect button or double-click on a network to establish a connection. 

The information displayed for each network will include at least the following items.

Standard Columns

Network
This is the Network Signal Set IDentifier (SSID). Essentially, this is just a name that is broadcast 
by a WiFi Access Point to identify the network.

If you see a *closed* item in this column, this indicates the presence of one or more closed 
networks. Connecting to such a network requires the creation of a profile for that network. See 
“Accessing a Closed Network” on page 61 for more information.

Signal Strength
A gauge showing the strength of the signal being broadcast from each network. Stronger 
signals tend to produce more reliable connections.

Preferred
An icon is displayed in this column for any WiFi Network that is currently listed in the Network 
Profiles window. This includes network profiles that have been pre-defined by Sprint, WiFi 
Networks for which you have created profiles and WiFi Networks for which a profile has been 
created automatically (see “Options for Connecting to a New Network” on page 55 for more 
about Automatic Profile Creation).
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Encryption
Networks that are encrypted will have the  icon in this column. The accompanying text 
indicates the encryption method. See “Introduction to WiFi Encryption” on page 62 for 
instructions on connecting to encrypted networks.

Mode
This column displays two possible entries:

Connect
This column provides connection/disconnection buttons for each available network

This network is in infrastructure mode. You will be connecting to a network 
through a dedicated wireless Access Point.

This network is in ad hoc mode. You will be connecting directly to another 
computer through its wireless Network Interface Card.
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Display Options

Right-clicking in the WiFi Networks List produces a menu that 
controls display options for the list. 

All of the items in the top section of this menu correspond to 
columns in the list of WiFi networks. In addition to the standard 
columns, several extended information columns are available (see 
page 60 for definitions of the extended information columns). 

Checked items will be displayed. Unchecked items will not be 
displayed. Select any item in this section to add or remove the 
accompanying check mark.

The remaining items in the menu are described below:

Show Closed Networks
When this item is checked, Sprint SmartView will indicate that one or more closed networks are 
present by displaying the word *closed* in the WiFi Networks List. Removing the check from this 
item will suppress the indication (*closed* will no longer appear when closed networks are 
detected).

Consolidate Networks
Since two or more hotspots that are broadcasting the same network name are almost certainly 
providing access to the same network, Sprint SmartView normally only lists one hotspot (the 
one with the strongest signal) for any given network name. If you would prefer that all hotspots 
that broadcast the same network name are listed individually, remove the check from this item.

Reset Columns
Select this item to restore all the check marks in the top section of this menu to their default 
states.

Show All Columns
Select this item to check all items in the top section of this menu.

Hide All Columns
Select this item to uncheck all items in the top section of this menu.
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Extended Information Columns

The list of available WiFi Networks shows only a few informational columns by default. The 
following additional columns can be added to the display using a menu that appears when 
you right click on the list.

BSSID
This is the MAC Address of the Access Point’s Wireless Network Interface Card.

Channel
The channel on which the Wireless Network is broadcasting.

AP Vendor
The manufacturer of the Wireless Access Point.

Beacon Period
Wireless Access Points periodically broadcast a packet called a “beacon” which helps to 
synchronize communications with connected systems. The number in this column 
indicates how often (in milliseconds) the beacon is transmitted.

Supported Rates
A list of all the transmission rates supported by this network.

Time First Seen
The time of day when Sprint SmartView first detected this network. Note that this value 
represents the current session only. It will be reset when you restart Sprint SmartView.

Time Last Seen
The time of day when Sprint SmartView last detected this network.
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Section 7D

Accessing a Closed Network

To access a closed network with Sprint SmartView, you must set up a network profile for that 
network. Follow these steps:

1. Select Profiles from the Tools menu. The Network Profiles window will now be displayed.

2. Select Add New Profile from the Settings menu. A list of network profile types now 
appears.

3. Select WiFi.

4. Click Add. The first page of properties for the new profile appears.

5. Enter the name of the network you want to add in the SSID field. The Network Name is 
case-sensitive and must be entered exactly as provided by the network administrator.

6. Check This is a non-broadcasted network (Closed) to identify this as a closed network.

7. Fill out the remaining fields on this page as instructed by the network administrator.

8. Click Next to continue to the General page. 

9. Configure the fields on the General page as desired.

10. Click Finish to exit.
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Section 7E

Introduction to WiFi Encryption

Unlike a wired local network, a wireless network cannot easily be protected from potential 
intruders by physical barriers such as walls. Since radio signals travel through physical 
objects, a potential intruder merely needs to listen with the right equipment to see the traffic 
traveling across a wireless network. For this reason, public wireless networks often employ 
encryption to protect their users.

To access an encrypted network you will need the Encryption Key used by the network you 
wish to access. 

Encryption Keys

An encryption key is a code key used to encrypt data exchanged between an encrypted 
network and Sprint SmartView. You cannot exchange data with an encrypted network 
without having the appropriate encryption key.

There are two ways to obtain an encryption key:

● Obtain a key from the administrator of the WiFi network you are trying to access.

● Configure 802.1x Authentication according to the instructions of the network's 
administrator. A key will be provided automatically as part of the login process.

802.1x Authentication

802.1x is a protocol that specifies the method Sprint SmartView will use to obtain an 
encryption key during the WiFi login process. It is really just a standard framework that 
specifies a second protocol, called an “EAP Type” (Extended Access Protocol) to 
accomplish most of its work. Therefore, when attempting to access a network that requires 
802.1x Authentication, you will need to correctly specify the EAP used and configure the 
options for that EAP. Consult the administrator of the WiFi network you are trying to access 
for the correct settings.

Because it requires a certain amount of infrastructure, 802.1x is typically used in office and 
enterprise environments.

What Does “PSK” Stand For?

PSK stands for “Pre-Shared Key.” it simply means that your encryption key has to be 
entered manually rather than obtained automatically using 802.1x. Because of their 
simplicity, PSK methods are the typical choice for home and small office environments.
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Wired Equivalent Privacy (WEP)

WEP was the standard encryption technology that was used in the early days of WiFi networks. 
More secure methods, such as WPA have since emerged, but WEP remains an extremely 
popular choice for encrypted networks. There are two variants of WEP:

● WEP Open: This is by far the most commonly-used version of WEP. Networks that use 
this variant don't bother to verify that you have the correct encryption key before allowing 
you to connect. After all, if you don't have the connect encryption key, you won't be able 
to communicate with the network anyway.

● WEP Shared: This variant forces you to prove you have the correct encryption key before 
it allows you to connect. It does this by sending out some sample text for Sprint 
SmartView to encrypt. If the result that the network gets back is what it expected, then it 
allows you to connect. Ironically, this is somewhat less secure than WEP Open because 
the verification process used gives potential intruders a large hint about the contents of 
the encryption key.

WiFi Protected Access (WPA and WPA2)

WiFi Protected Access (WPA) is a key improvement to WiFi data security for both enterprises 
and home users. It was developed when an industry trade group known as the WiFi Alliance 
became concerned that the security in the existing WEP Standard was insufficient. They quickly 
issued an interim standard that would address most of their concerns while they developed a 
more complete Final Standard. The interim standard would become known as WPA, while the 
final standard would be termed WPA2.

Because 802.1x is a required component of WPA, both WPA and WPA2 provide an upgrade 
path for enterprises that allows them to preserve existing investments in 802.1x/EAP 
Authentication capabilities. In addition, home users can take advantage of a Pre-Shared Key 
mode in WPA and WPA2 which allows the encryption and network protection capabilities to 
function on a home network as well.

To use WPA, you will need a WPA-compliant WiFi device.

What are TKIP and AES?

Temporal Key Integrity Protocol (TKIP) and Advanced Encryption Standard (AES) are different 
encryption protocols that can be used with WPA. TKIP is the method that was called for in the 
original WPA Specification. AES, which is even more secure, was added as an alternate method 
to later versions of the specification. So, if the network uses WPA, but doesn't specify which of 
these it uses, TKIP is the most likely of these to be supported by the network.
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Section 7F

Accessing an Encrypted Network

The steps required to connect to an encrypted WiFi network are the same as those required 
to connect to a non-encrypted WiFi network — until you click Connect. When you click 
Connect, the software will display a dialog that prompts you to enter a network encryption 
key. To proceed, you must do one of the following:

● Enter a network encryption key obtained from the network administrator.

● Configure 802.1x Authentication as instructed by the network administrator.

When you are finished, click the Connect button on the prompt dialog to proceed.

Tip You can create a profile containing the appropriate encryption information to avoid 
having to manually having to enter an encryption key each time you connect. See 
“Creating a Profile for a WiFi Network” on page 112 for more information.
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Section 7G

WiFi Location Finder

Location Finder is an application that makes it easy to find nearby WiFi Access Points that are 
provided by Sprint’s partner networks. Sprint SmartView automates the process of connecting 
to these networks to make establishing connections as simple as possible.

To access Location Finder from the new interface:
� Select WiFi Location Finder from the Application Launch Menu.

To access Location Finder from the classic interface:

� Click  in the Application Bar.

To search for Access Points:
1. In the upper-left corner of the Location Finder window, select the country in which you 

wish to search.

2. You can narrow your search to a specific area by filling in more of the fields in the left 
column. For some countries, a map will appear on the right that allows selecting a specific 
region or city by clicking on it.

3. Click the Search button. Location Finder will display a list of found locations organized by 
location type

4. Select the Access Point you wish to use from the displayed options. 

Tip Clicking on any Access Point found will display a short informational message about 
that location.
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Section 8A

About Dialup on the Sprint SmartView Software

Traditional Dialup access via modem is supported only on selected versions of the Sprint 
SmartView software. If you are using Sprint SmartView’s “new” interface, support for dialup will 
be indicated by the appearance of the Dialup icon in the main window. Additionally, Analog 
Dial-up Devices and ISDN Devices headings will appear in the Hardware tab of the Settings 
window.

Section 8B

Manually Connecting to a Dialup Network

Using the New Interface
1. If you have not already done so, enter your user ID and password for the dialup 

connection in the User Name and Password Logon window.

2. If your modem is not already connected to your computer, connect it now. When your 
modem is ready, the Dial-up button will display the Ready state (see “Connection State” 
on page 20). If you have at least one dialup network profile, Sprint SmartView will select a 
profile to use for connection.

3. Specify the number to dial by doing one of the following:

� Click the Dial-up button to connect using the dialup profile that Sprint SmartView 
selected.

� Click the arrow ( ) beneath on the Dial-up button. This produces a list of all 
available dialup network profiles. You can establish a connection using any profile 
listed simply by selecting it from the menu.

� Establishing a connection using a number to dial not found in any current dialup 
network profile usually requires creating a new dialup network profile. However, if you 
do not yet have any dialup network profiles, you can just click the Dial-Up button. This 
opens the Please enter a number window, which allows you to enter the desired 
connection information.

Tip Hover over the Dial-up button if you want to see details about the network profile 
Sprint SmartView has selected.
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Using the Classic Interface
Since the classic interface does not have a Dialup tab in the main window, Dialup 
connections must be established in the Network Profiles window. Follow these steps:

1. Open the Network Profiles window by selecting Profiles from the Tools menu.

2. Select the dialup network profile containing the number that your modem should dial 
for this connection.

If you do not yet have a profile containing the correct number, you must create one 
and select it now.

3. Click the Connect button.
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Section 8C

Entering a Number to Dial

If you click the Dial-up button in the main window, without having any dialup network profiles 
defined, the Please enter a number window appears. This window allows you to enter the 
telephone number that your modem should dial in order to establish a dialup connection. 

Follow these steps to enter the appropriate number:

1. By default access telephone numbers are assumed to be local (i.e. you do not need to 
dial an Area Code or other prefix prior to the number itself). If this number requires that 
you dial the Area Code or you need to dial a special prefix prior to dialing this number, 
check the Use dial properties box and then click the Dial Properties button to configure 
the appropriate settings. 

2. If the Area Code must be dialed before this number, enter it now.

3. Enter the local portion of the number to be dialed (the portion that follows the area code) 
in the space marked Phone number.

4. Select the Country in which the number to be dialed is located.

5. If you wish to use an modem for this connection, select “Analog” in the Connection Type 
menu. If you wish to use an ISDN terminal adapter (for use on ISDN phone lines), select 
“ISDN.”
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Section 8D

Dial Properties

This window appears when you click the Dial Properties button in either of the following 
locations.

● The Dialup page of the Profile Properties window/New Profile Wizard.

● The Please enter a number window.

The window allows you to configure the formatting of telephone numbers to be dialed by 
your modem.

The following fields are included in this window:

Location same as selected number
Check this box if you are dialing from the same Area Code and country as the number you 
are dialing.

I am in
Select the country that you will be dialing from.

My Area Code is
Enter the Area Code you will be dialing from
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Area Code rule
Specify whether the number to be dialed should be formatted as a local call, as a long distance 
call or as an international call. 

To access an outside line, I dial
If you have to dial an additional code to access an outside line, enter that code here. When 
such a number is used, it is typically either 9 or 8.

To disable call waiting, I dial
Call waiting can disrupt modem communications. If you have a call waiting feature on the line 
from which you are dialing, it is recommended that it be disabled during modem 
communications. The modem can handle this automatically by dialing the correct disable code 
(which disables call waiting for the duration of the current call only). To allow the modem to do 
this, enter the correct call waiting disable code here (check with your telephone service provider 
for the correct code).

I dial using
Select the type of dialing tone for the phone system you are using. Most phone systems use 
tone-dialing. Pulse dialing (also known as rotary dialing), is still in use on older phone systems.

My calling card
If you would like to use a calling card when dialing this number, Check the Use my call card 
box. Then, select the calling card you wish to use from the list below.

Note If your calling card does not yet appear in this list, you can add it by clicking the Add 
New button and then entering information about your card in the form that appears.
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Section 9A

About Ethernet on the Sprint SmartView Software

Ethernet is the most common method that computers use to establish wired (non-wireless) 
connections to networks. Perhaps you just know it as the network port on the back of your 
computer or as the cable (attached to that port) that leads to your local network at work. At 
home, you may know it as the line that attaches your computer to a cable modem or a DSL 
modem.

Although Microsoft Windows connects to Ethernet networks automatically when you attach an 
Ethernet network cable to your computer, the Sprint SmartView software can detect when such 
a connection occurs and (if desired) shut down its own connections in response.

Additionally, some versions of the Sprint SmartView software provide enhanced functionality for 
managing Ethernet connections. The enhancements provided include the ability to do the 
following:

● manually disconnect from an Ethernet network and reconnect to it without detaching the 
cable from your computer. 

● automatically launch selected applications when you successfully establish an Ethernet 
connection.

● automatically log into a VPN when you sucessfully establish an Ethernet connection

● specify the priority of individual Ethernet networks in the Network Profiles window.

If you are using Sprint SmartView’s new interface, support for enhanced Ethernet management 
will be indicated by the appearance of the Ethernet icon in the main window. Additionally, an 
Ethernet Devices heading will appear in the Hardware tab of the Settings window.
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Section 9B

Manually Connecting to an Ethernet Network

Manual connections to Ethernet networks can be established only on versions of the Sprint 
SmartView software with enhanced Ethernet functionality.

Using the New Interface
Follow these steps to establish a connection to an Ethernet network. 

1. Connect the Ethernet port on your computer to a cable belonging to the network to 
which you wish to connect. Sprint SmartView will search for an Ethernet network 
profile that matches the network you attached. When it is finished, the Ethernet button 
in Sprint SmartView’s main window will display the Ready state (see “Connection 
State” on page 20).

2. Do one of the following to connect 

� Click the Ethernet button to connect using the Ethernet network profile that Sprint 
SmartView selected. 

� Click the arrow ( ) beneath the Ethernet button. This produces a list of all 
Ethernet network profiles that match the attached network. You can establish a 
connection using any profile listed simply by selecting it from the menu.

Using the Classic Interface
Since the classic interface does not have an Ethernet tab in the main window, Manually 
establishing an Ethernet connection can only be carried out in the Network Profiles 
window. Follow these steps:

1. Connect the Ethernet port on your computer to a cable belonging to the network to 
which you wish to connect.

2. Open the Network Profiles window by selecting Profiles from the Tools menu.

3. Select a network profile that matches the Ethernet network you just attached.

If you do not yet have a profile that matches this network, you must create one and 
select it now.

4. Click the Connect button.

Note Hover over the Ethernet button if you want to see details about the network profile 
Sprint SmartView has selected.
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Section 10A

Launching External Applications

Both the new user interface and the classic user interface of the Sprint SmartView software 
have 

In the new user interface, the Application Launch Menu 
is a pull down list of applications that appears in the 
lower left corner of Sprint SmartView's main window. 

Select an application from this menu to launch that 
application. 

In the classic interface, the application bar is a row of icons that appears beneath the main 
window when you click the Applications button. Clicking an icon will launch the application 
associated with that icon, and clicking the same icon again will close the application. 

In either version of the interface, the following applications are listed by default:

You can add additional icons to the Application Bar and the Application Menu using the App 
Launcher tab in the Settings window. See “Adding an Application” on page 79 for more 
information.

Note In the classic interface, active icons (the ones you have clicked) are displayed in color. 
Inactive icons are displayed in black and white.

Coverage Maps. Opens your Web browser to a Web site containing Mobile 
Broadband Network coverage information. From this site, enter your current Zip 
Code, click View Coverage, and then select the Sprint Power Vision® Network to 
get information about coverage in your area.

Connection Speed. Tests and displays your Mobile Broadband connection 
speed.

Support. Connects to online support for your Mobile Broadband Device.

Account. Gives you access to your Sprint account and allows you to check usage 
data.

Location Finder. Opens the Location Finder. See “WiFi Location Finder” on 
page 65 for more information.

Digital Lounge. Links you to the Digital Lounge.
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Section 10B

The App Launcher Tab

The App Launcher tab in the Settings window is used to specify which applications should 
appear in the Application Launch Menu and the Application Bar. The settings here also 
control launch-related details such as launch delays and Sprint SmartView’s response 
when a launched application is shut down.

Opening the App Launcher Tab
� Select Tools > Settings, then click the App Launcher tab.
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Section 10C

Adding an Application

Follow these steps to add an application to the list in the App Launcher settings tab:

1. On the App Launcher tab, click Add. The Application Configuration window (see page 
84) appears.

2. Enter the name of the application that you are adding in the Profile Name box. The name 
entered here will be displayed in the App Launcher tab.

3. Click the Browse button next to the box marked File.

4. Select the file you wish to add to the list and then click the OK button.

5. If the application requires any additional parameters to be entered on the command line 
when it is launched, you can enter them in the Parameters box.

6. If you want to use an icon other than the application’s default icon, click the Browse 
button next to the box marked Icon. You may select either an icon (.ico) file or an 
executable (.exe) file. When you are finished selecting the file, click OK to return to the 
Application Configuration window.

7. If you are using Sprint SmartView's “classic” interface, specify where in the Application 
Bar you want this icon to appear by selecting a number in the Toolbar Position box.

8. Click OK.

Note Executable files may contain multiple icons. By default, Sprint SmartView will 
select the application's primary icon. Ordinarily, this means that you don’t have 
to change the value in the Icon Index box. However, if you choose a different 
icon file is step 6 and that file is an executable (.exe) file, you must enter the 
index of the icon you wish to use. For example, if you want to use the first icon 
in the file, enter the number “1.”
79        Section 10C, Adding an Application



Th
e 

A
pp

lic
at

io
n 

B
ar
Section 10D

Editing the Settings for a Launched Application

The parameters used to launch an application are found in two locations: the Application 
Configuration window and the Monitor Details window.

To change settings in the Application Configuration window:
1. In the App Launcher tab of the Settings window, select the application whose 

parameters you wish to edit.

2. Click Edit. The Application Configuration window appears.

3. Make any desired changes. (See page 84 for descriptions of the individual 
parameters.)

4. Click OK when you are finished.

To change settings in the Monitor Details window:
1. In the App Launcher tab, click the  button corresponding to the application 

whose parameters you wish to edit. The Monitor Details window appears.

2. Make any desired changes. (Descriptions for the parameters in this window start on 
page 86.)

3. Click OK when you are finished.

Note You cannot edit the parameters for the applications added to this list by Sprint.
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Section 10E

Launching an Application Automatically

Applications can be automatically launched when you connect to particular network profiles. 
Follow these steps to configure automatic application launching:

1. Ensure that the application you wish to launch appears in the list on the App Launcher 
settings tab (see “Adding an Application” on page 79).

2. In the App Launcher tab, click the  button next to the application that you wish 
to autolaunch. The Monitor Details window appears (see page 86).

3. If you want to be prompted before the application is launched automatically, select 
“Prompt” in the Launch options box. Otherwise, select “Auto.”

4. If you don’t want the application to launch immediately upon making a connection, enter a 
time delay (in seconds) in the Launch Delay box. 

5. Click OK to exit the Monitor Details window.

6. Click OK to exit the Settings window.

7. Select Tools > Profiles from the menu bar in the main window.

8. Select the profile with which you wish to launch the applications you specified earlier.

9. Click the Edit button. The Profile Properties window appears.

10. On the General tab, check Enable Application Launcher.

11. Click OK to exit the Profile Properties window.

Special Cases

Internet Explorer and your VPN Client software are special cases. Although you can add either 
Internet Explorer or a VPN Client to the list of launched applications here, it is not the easiest or 
the most flexible way to launch these applications.

● Each network profile has a dedicated setting that specifies whether Internet Explorer 
should be launched upon successful connection. See “Profile Properties: General” on 
page 132 for more information.

● Sprint SmartView includes a dedicated interface for configuring and launching VPN 
Clients. You must use this interface if you wish to take advantage of the enhanced VPN 
functions provided by the Sprint SmartView software. See “Automatically Launching a 
VPN Connection” on page 107 for more information.

Note This is only necessary if the application is not functioning correctly because it 
is being launched too quickly after a connection is established. Applications 
that must run over a VPN connection are the most likely to require such a 
delay because your VPN Client software may take some time to launch and 
log into a VPN.
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Section 10F

Changing the Order in Which Applications are Launched

The order in which applications are launched is controlled by the amount of launch delay 
specified in Monitor Details window. Applications with a greater delay will be launched later 
than applications with a smaller delay. Follow these steps to change the launch delay:

1. In the App Launcher tab, click the  button next to the application whose 
launch order you wish to change. The Monitor Details window appears (see page 86).

2. Increase or decrease the Launch Delay to make the application launch sooner or later 
than other applications. 

3. Click OK to exit the Monitor Details window.

Section 10G

Stopping an Application from Being Launched

Do one of the following to prevent an application from launching automatically when you 
connect to an associated network profile:

● Remove the application from the list displayed in the App Launcher tab of the 
Settings window. To do this, select the application you want to remove and then click 
Remove. Note that this also removes the application from the Application Bar (classic 
interface) and the Application Launch Menu (new interface).

● Configure the application for Manual Launch only by clicking the  button 
corresponding to the application on the App Launcher tab. and then selecting 
Manual in the Launch Options list.

● Prevent all applications from being launched with a particular network profile by 
unchecking the Enable Application Launcher box on the General tab of the Profile 
Properties window.

Note If Launch Delay is already set to 0 and you want this application to launch sooner 
than other applications, it is necessary to increase the Launch Delay setting of 
the other applications.

Note All of these options are available for applications that you have added. However, only 
the last option is available for applications Sprint has added to the App. Launcher tab.
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Section 10H

Monitoring Launched Applications

Sprint SmartView can be configured to respond when one of the applications listed in the App 
Launcher settings tab is shut down, for example, by shutting down your connection or by 
restarting the application. 

Follow these steps to enable the monitoring of a specific application:

1. Ensure that the application you wish to monitor appears in the list in the App Launcher 
settings tab (see “Adding an Application” on page 79).

2. In the App Launcher tab, click the  button next to the application that you wish 
to launch automatically. The Monitor Details window appears (see page 86).

3. In the Monitor Action list, select what Sprint SmartView should do if the application shuts 
down. Possibilities include:

� Manual (take no action).

� Disconnect from your current wireless connection.

� Restart the application that was shut down.

� Prompt you to select an appropriate response.

4. Click OK to return to the App Launcher tab.
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Section 10I

The Application Configuration Window

This window allows you to select an application to be added to the list of launched 
applications in the App Launcher settings tab and/or edit the parameters Sprint SmartView 
uses to launch that application. 

Profile Name
This is the name that will be displayed for this application in the App Launcher tab of the 
Settings window.

File / Browse
To select the application to be launched, do one of the following:

● Click Browse, locate the file you want to launch and then click the OK button.

● Type the complete path and filename of the file you wish to launch in the File box.

Parameters
If you wish to specify any command line parameters to use when launching this file, you 
may enter them in this box. Most applications do not require such parameters to launch, but 
some may use them to configure particular options. See the documentation for the 
application you wish to launch for more information about command line parameters that 
the application supports.

Note Specifying a file automatically fills in the Icon Index and Icon fields below.
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Test
Click this button if you wish to verify that the application launches correctly. Sprint SmartView 
will attempt to launch the software with the configuration you have specified.

Icon Index
Since executable (.exe) files can contain multiple icons, this field can be used to specify which 
icon in such a file to use. 

Toolbar Position
If you are using Sprint SmartView's classic interface, the number here indicates the position in 
which this icon will appear on the Application Bar. The higher the number, the further to the 
right it will appear.

Icon / Browse
By default, Sprint SmartView will use the primary icon from the executable file selected above. 
To select an icon from a different file, do one of the following:

● Click Browse, locate the file that contains the icon you wish to use and then click the OK 
button.

● Type the complete path and filename of the file containing the icon you wish to use in the 
Icon box.

Toolbar Tooltip
If you are using Sprint SmartView's classic interface, you may enter the text for the tooltip that 
will appear when you hover over this application’s icon in the Application Bar. 

Note This is automatically populated when an executable file is selected above.
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Section 10J

The Monitor Details Window

The Monitor Details window allows you to specify whether a given application listed in the 
App Launcher tab will be launched automatically when you connect and what actions 
Sprint SmartView should take when that application is shut down.

Launch options
This setting determines whether an application should be launched automatically when you 
successfully establish a connection using certain profiles. (See “Launching an Application 
Automatically” on page 81 for more information.)

● Manual — The application will not be launched automatically.

● Prompt — Sprint SmartView will prompt you before launching the application.
● Auto — The application will be launched automatically (without prompting you).

Launch Delay (sec)
If Launch options is set to Auto, Sprint SmartView will wait the number of seconds specified 
here before launching the application. The delay period begins immediately after a 
successful connection is made. 

Monitor Application
Check this box if you want Sprint SmartView to monitor this application and to take a 
specified action when the application is shut down.

Note In most cases, a delay is not necessary. It is only needed when launching an application 
too quickly causes a problem.
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Monitor Action
If Monitor Action is checked, this field specifies what Sprint SmartView should do when it 
detects that this application has been shut down.

● Manual — Sprint SmartView will not respond to the application being shut down.

● Prompt — Sprint SmartView will prompt you for a course of action.

● Restart — Sprint SmartView will restart the application.
● Disconnect — Sprint SmartView will shut down your current connection.

Monitor Cycle (sec)
Determines how often Sprint SmartView should check to see if the application is still running. 
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Section 11A

Requirements for GPS Service

You will need the following to access GPS services with the Sprint SmartView software:

● You must be using a Sprint Mobile Broadband data card containing a GPS receiver. GPS 
receivers in mobile phones are not currently supported.

● You must have a valid Sprint Mobile Broadband subscription

● You must agree to the privacy agreements that appear when you attempt to access 
Sprint SmartView’s GPS functions.

● GPS must be enabled. See “Enabling and Disabling GPS” on page 91 for more 
information.

● Some additional configuration may be required in order to use third-party GPS software. 
See “Working With Third Party GPS Applications” on page 98 for more information.

However, GPS services will not be available if any of the following are true:

● Your Mobile Broadband device has been set to CDMA EVDO only. See “Mode” on 
page 142.

● You are using a dual mode CDMA/WiMAX Mobile Broadband device and that device is 
currently connected to a WiMAX network.

● You are currently indoors. GPS receivers must be able to lock onto the global positioning 
satellites to accurately determine position. The number of obstructions present indoors 
often makes accurate position determination impossible. 

Section 11B

Mobile-Originated vs. Network-Originated GPS

GPS queries can be originated either by your Mobile Broadband device or by the Sprint 
network:

● Mobile-originated queries are generated when you use software on your computer or on 
your Mobile Broadband Device to retrieve location data. Applications in this class include 
any mapping and navigation software that can be installed on your computer. 

● Network-originated queries are generated when the Sprint network needs to locate your 
device. This is the method that is used when your device needs to be located in an 
emergency. However, it is also possible for applications to use this method to obtain the 
position of your device from the Sprint location server. 
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Privacy Concerns for Network-Originated GPS

Since Network-Originated queries are initiated by the network rather than the user, there 
really isn’t anything you need to do to use this feature. However, if you are surprised or 
concerned about the fact that the Sprint network can track your device’s location, you can 
employ what’s called”privacy mode” to block network-originated GPS queries. What is 
privacy mode? Simply put, when GPS is disabled, both mobile-originated and network-
originated queries are disabled. So, when you are not actively using GPS, you can disable it 
if you wish to avoid the possibility of being tracked (see “Enabling and Disabling GPS” on 
page 91 for instructions).

At any given time, you can determine whether privacy mode is on by looking at the Privacy 
Indicator icon near the upper right corner of the main user interface. It has three states:

Modes of Mobile-Originated Service

There are currently two modes of mobile-originated GPS service. Some devices support 
only one of these. Others support both.

● Basic — this is the default mode of all GPS-capable Mobile Broadband devices. In 
this mode, the Sprint network helps the device to obtain its initial fix on GPS satellites. 
This has the effect of allowing the device to obtain its initial position reading 
somewhat faster than a device in standalone mode would be able to. However, this 
mode requires access to the Sprint Network. When the Sprint Network is not 
available, Sprint SmartView will offer to switch to Standalone mode (if your device 
supports it). 

● Standalone — in this mode, your Mobile Broadband device acts as a completely 
standalone GPS receiver. It does not query the Sprint Network for location data. This 
has the advantage of being available when you are roaming, but it may take longer to 
obtain initial position data from the device.

Privacy on/GPS disabled. You cannot be tracked using GPS. Nor can you use other 
GPS functions.

Privacy off/GPS enabled. GPS is currently enabled and the network can use it to 
locate you. 

(no icon) No GPS device (Privacy on). The privacy icon does not appear if no GPS-capable 
Mobile Broadband device currently attached to your computer. It also appears if you 
have checked the Disable GPS on Device field on the Location/GPS settings tab. In 
either of these cases, GPS is disabled for the entire Sprint SmartView application.

Note If your device supports both modes, you can specify which mode will be used by 
default using the GPS Mode setting on the Location/GPS tab of the Settings 
window.
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Section 11C

Enabling and Disabling GPS

Using the GPS receiver in your Mobile Broadband device requires that you enable GPS in the 
Sprint SmartView Application. Using external, third party GPS applications requires that you 
enable NMEA. 

Enabling GPS and NMEA in the New Interface

If you are using the new interface, clicking the GPS icon in the main window cycles though the 
three states shown below:

Additionally, GPS will be enabled automatically if you initiate a search using the GPS Search 
Menu. Both GPS and NMEA will be enabled automatically if you attempt to launch an 
application using the GPS Applications Menu.

Enabling GPS and NMEA in the Classic Interlace

If you are using the classic interface, you can enable GPS by opening the GPS Bar (see page 
93).

Once the GPS Bar is open, you can enable NMEA by clicking the button. The button 
changes to . Click again to disable NMEA.

Closing the GPS Bar disables both GPS and NMEA.

Shutting Off GPS Entirely

If you wish to disable GPS entirely, check the the Disable GPS on Device field on the Location/GPS 
settings tab (see page 147). This disables GPS functionality and removes all GPS-related items 
from SmartView’s user interface.

(gray)

GPS and NMEA disabled. In this state, GPS data is not received by the 
Sprint SmartView application.

(white)

GPS enabled/NMEA disabled. In this state, GPS data is received by the 
Sprint SmartView application, but the received data is not shared with third 
party GPS applications.

(yellow)

GPS and NMEA enabled. In this state, GPS data is received by the Sprint 
SmartView application and data is shared with third party GPS applications.
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Section 11D

The GPS Search Menu (New Interface)

If you are using Sprint SmartView's new interface and your Mobile Broadband Device 
contains a GPS receiver, you can use the GPS Search Menu to search for the nearest 
restaurants, gas stations and other amenities. This pull-down menu appears on the bottom 
of the Main Window, just to the right of the Application Launch Menu.

To perform a search, 

1. Specify the type of location to search for by doing one of the following:

� Pull down the menu to select one of the predefined searches (see below)

� Type what you are looking for in the box at the top of the menu (Sprint SmartView 
will search for the nearest examples of whatever you typed and then add this 
search to the menu).

2. Click the Find button.

Predefined Searches

The following search items are predefined by Sprint:

● Sprint Stores

● Local Restaurants
● Local Banks

● Local Hotels

● Local Gas Stations
● Local Coffee Houses

Note As custom searches are added, the list can potentially become quite long. Items can 
be removed from the list using the window that appears when you click the 
Configure GPS Applications button in the Location/GPS tab of the settings window.

Note The Sprint SmartView software does not currently support GPS receivers on phone 
handset devices.
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Section 11E

The GPS Applications Menu (New Interface)

If you are using Sprint SmartView's new interface, clicking the arrow to the right of the icon 
opens the GPS Applications Menu. This menu can be used to quickly launch applications that 
require GPS input (such as mapping utilities and other location-based applications).

By default, there are no applications listed here, but you can add GPS applications to the menu 
in the GPS Applications Window. See “Adding a GPS Application to the GPS Applications 
Window” on page 100 for more information.

Section 11F

The GPS Bar (Classic Interface)

If you are using Sprint SmartView's classic interface, the GPS bar appears below the main 
window when you click the GPS button. If your Mobile Broadband device includes a supported 
GPS Receiver, you can use the GPS Bar to determine your current location and to quickly 
search for hotels, restaurants, and other nearby services.

When you first open this interface, Privacy Consent Agreements will be displayed; to use GPS, 
you must accept them.

GPS Device Status
This has three possible values:

● Off — Indicates that your device’s GPS receiver is turned off.

● Searching — Your device is searching for satellites. Your device’s GPS receiver must 
acquire at least three satellites to provide latitude and longitude data, and four satellites to 
provide altitude data.

● Acquired — Your device’s GPS receiver has acquired a sufficient number of satellites to 
provide latitude, longitude, and altitude data.

GPS device
status

Data received
from your GPS Device

Sprint-Defined Shortcuts - Click these to
search for nearby hotels, restaurants, etc.

User-Defined
Shortcuts

Share your GPS device
with other applications
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Data Received
These fields display the raw location data generated by your device’s GPS receiver. See 
“GPS Data Fields” on page 96 for descriptions of individual fields.

Sprint-Defined Shortcuts
Clicking an icon in this group opens a map showing location of the nearest business or 
feature represented by the icon. Click the same icon again to close the map. 

The most versatile of these is the magnifying glass icon, which allows you to simply type 
what you would like to find. For example, typing “Joe's Burgers” would search for the 
nearest restaurant by that name. The other standard GPS Icons search for all instances of 
specific types of businesses or services (hotels, gas stations, etc.).

See “Standard GPS Icons” on page 95 for explanations of these icons.

User-Defined Shortcuts
You can add your own shortcut icons to the GPS Bar using the Configure GPS 
Applications interface. Perform these steps to display this interface:

1. Select Settings in the Tools menu.

2. Select the Location/GPS tab.

3. Click Configure GPS Applications.

The procedure for adding a shortcut to the GPS Bar is the similar to the procedure for 
adding a shortcut to the Application Bar. See “Adding a GPS Application to the GPS 
Applications Window” on page 100 for more information.

Sharing Your GPS Device
Ordinarily, your device’s GPS receiver can be used only with the applications in Sprint 
SmartView. To use your device’s GPS receiver with third-party applications, click the arrow 
button in the lower right corner of the GPS Bar. Sprint SmartView will provide an interface 
that allows your device’s GPS Receiver to be recognized by standard GPS software.

Note Your device’s GPS receiver must be turned on and your device must have a network 
connection in order to use this feature.

Note To use this functionality, you must agree to the Privacy Consent Agreement that 
appears when this button is clicked.
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Standard GPS Icons 

Sprint SmartView’s GPS Bar contains the following predefined icons:

To search for a business or service based on search terms that you enter.

Search for the nearest Sprint store.

Search for the nearest restaurant.

Search for the nearest bank.

Search for the nearest hotel.

Search for the nearest gas station.

Search for the nearest coffee shop

Note Active icons (the ones you have clicked) are displayed in color. Inactive icons are 
displayed in black and white.
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Section 11G

GPS Data Fields

The following data fields appear on the Location/GPS tab of the settings page, in the popup 
that appears when you hover over the GPS icon in the new interface, and near the top of 
the GPS Bar in the classic interface:

● GPS Port — The next available NMEA Port available for use by a GPS Application. 
Some applications require you to enter this port number.

● Heading — The approximate direction in which you are moving. Compass headings 
range from 0 degrees (due North) to 360, with 90 being due East, 180 being due 
South, etc.

● Speed — The estimated speed at which you are moving.

● Latitude — Your current latitude, expressed in degrees and rounded to four decimal 
places. Positive numbers are used for locations north of the equator. Negative 
numbers are used for locations south of the equator. Zero is the equator itself.

● Longitude — Your current longitude, expressed in degrees and rounded to four 
decimal places. Positive numbers indicate locations east of the Prime Meridian 
(which passes through Greenwich, England). Negative numbers indicate locations 
west of the Prime Meridian.

● HEPE — Horizontal Estimated Position Error. This is a measure of the accuracy of your 
calculated position. So, if the HEPE is 43 feet, you could be as much as 43 feet from 
the coordinates indicates by your device’s GPS receiver.

● Satellites — The number of satellites your GPS receiver has acquired. At least three 
are required to provide latitude and longitude and four are required to provide an 
altitude. Additional satellites provide greater accuracy (seven or more is considered 
excellent).

● Last Fix — The date and time that your device’s GPS receiver was last able to update 
its location data.

● Altitude — Your current altitude above Sea Level (in feet). Note that because of the 
inherent difficultly in determining altitude via GPS, the margin of error for altitude may 
be somewhat larger than the HEPE (the margin of error for latitude and longitude).
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Section 11H

GPS Applications Window

This window is reached by clicking the Configure GPS Applications button on the Location/
GPS tab of the Settings window. It is nearly identical to the App Launcher settings tab 
described on pages 78 to 96 and configuring applications differs very little from one to the 
other. However the following differences should be noted:

● The applications configured here are assumed to be GPS-aware (for example: mapping 
applications). If you are using the classic interface, such applications will appear in the 
GPS Bar rather than the Application Bar. If you are using the new interface, such 
applications appear in the GPS Applications Menu rather than the Application Launch 
Menu.

● Unlike the App Launcher settings tab, the list here also contains search items. In the 
classic interface, these appear as additional icons on the GPS Bar. In the “new” interlace, 
these appear in the GPS Search Menu. Note, however, that you cannot add new search 
items in this window. If you are using the new interface, you can add new search items by 
typing them into the box at the top of the GPS Search Menu.

● GPS applications must be assigned an NMEA port (see “GPS/NMEA COM Ports” on 
page 98). Sprint SmartView uses this port to send the data generated by your GPS 
receiver to the application.

● As a result of the above differences, the procedure to add a new GPS applications differs 
somewhat from the process described on page 79. See “Adding a GPS Application to 
the GPS Applications Window” on page 100 for the GPS-specific version of this 
procedure.
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Section 11I

Working With Third Party GPS Applications

The Sprint SmartView software allows you to share the GPS data generated by your Mobile 
Broadband device with third party GPS applications. Typically, such applications assume 
that the GPS receiver is attached to a communications (COM) port on your computer and 
that the data it outputs is formatted according to the NMEA standard for GPS data. The GPS 
receiver on your Mobile Broadband device, however, is attached to your computer through 
an entirely different kind of port. To remedy this, the Sprint SmartView software creates three 
virtual COM ports to which it can forward NMEA GPS data. 

To share GPS data with a third party application, you must do the following:

● Enable GPS and NMEA. See “Enabling and Disabling GPS” on page 91 for more 
information.

● Identify the GPS/NMEA ports created by the Sprint SmartView software. See “GPS/
NMEA COM Ports,” below.

● Configure your third party software to use one of Sprint SmartView’s three GPS/
NMEA ports (consult the documentation that came with third party application).

● Add the application to the GPS Applications Menu (new interface) or GPS Bar 
(classic interface). See “Adding a GPS Application to the GPS Applications Window” 
on page 100. 

GPS/NMEA COM Ports

When you are configuring an application that uses GPS data, the application may ask you 
to enter the number of the COM port over which it will be receiving this data. 

Sprint SmartView actually provides three such ports for use by other applications. Specific 
ports can be assigned to applications when you are adding them to the GPS Bar (classic 
interface) or the GPS Applications menu (new interface). First, however, you must identify 
the three COM ports Sprint SmartView has provided. The exact procedure for doing this is 
unique to each version of Windows.

Windows 2000
1. Right click on the My Computer icon on your desktop and then select Properties from 

the menu that appears.

2. Select the Hardware tab.

3. Click the Device Manager button. The Device Manager appears. The three virtual 
ports created by Sprint SmartView are listed under the Ports (COM & LPT) heading of 
this window.
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Windows XP
1. Display the Windows System Properties folder. The procedure for doing this varies 

depending on whether “My Computer” is on your desktop or in the first level of the Start 
menu. 

If it's on your desktop, right click on the My Computer icon and then select Properties 
from the menu that appears.

If it's on the first level of the Start menu, select My Computer from the Start menu and then 
click View System Information in the left column of the window that appears.

2. Select the Hardware tab.

3. Click the Device Manager button. The Device Manager appears. The three virtual ports 
created by Sprint SmartView are listed under the Ports (COM & LPT) heading of this 
window.

Windows Vista
1. Display the Windows System Properties folder. The procedure for doing this varies 

depending on whether “Computer” is on your desktop or in the first level of the Start 
menu. 

If it's on your desktop, right click on the Computer icon and then select Properties from 
the menu that appears.

If it's on the first level of the Start menu, select Computer from the Start menu and then 
click System Properties at the top of the window that appears.

2. Click the Device Manager link in the left column. The Device Manager appears. The three 
virtual ports created by Sprint SmartView are listed under the Ports (COM & LPT) heading 
of this window.
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Adding a GPS Application to the GPS Applications Window

Follow these steps to add an application to the list in the GPS Applications window. 

1. In the Location/GPS tab of the settings window, click the Configure GPS Applications 
button. The GPS Applications window appears.

2. Click the Add button. The Application Configuration window appears.

3. In the Profile Name box, enter the name of the application that you are adding. The 
name entered here will be displayed in the Application Configuration window.

4. Click the Browse button next to the box marked File.

5. Select the file you wish to add to the list and then click OK.

6. The NMEA COM port (see page 100) to be used by the GPS application must be 
specified in the Parameters box. There are two ways to enter this:

� Assign a specific COM port to the application by entering the number directly (for 
example COM33). Note, however, if another GPS application is already using this 
port when you open this application, this application will not be able to receive 
data. Be careful not to assign the same number to two GPS applications that are 
likely to be open at the same time.

� Instruct Sprint SmartView to assign the application the next available port each 
time the application is opened. To do this, enter $NMEAPORT. In this case, 
however, you won't necessarily know the number of the port assigned to the 
application.

7. Click OK.

Note This space can also perform the function it is used for in the non-GPS version 
of this window — specifying additional command line parameters to be used 
when launching the application. In this version of the window, however, the 
additional parameters must be enclosed in parenthesis.

Note If you are using Sprint SmartView’s new interface, applications added using this 
procedure will appear in the GPS Applications Menu rather than the GPS Search 
Menu. If you wish to add an item to the GPS Search Menu, just type the text you 
want to search for into the box at the top of the menu itself.
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Application Configuration Example: Microsoft Streets & Trips 2008

1. Identify the GPS/NMEA ports that have been added to your system by the Sprint 
SmartView software (see page 98 for instructions specific to each version of Windows). 

2. Open Microsoft Streets & Trips 2008.

3. In the menus of the Streets and Trips software, select Tools > GPS > Configure GPS 
Receiver. The GPS Receiver Settings window appears as shown below.

4. In the list of ports at the bottom of the page, select one of the three ports identified in step 
1. If possible, choose a port that you have not yet assigned to another piece of GPS 
software (each port may be used by only one application at a time).

5. Click OK. You may exit the Streets & Maps application now, if desired.

6. In Sprint SmartView, select Settings from the Tools menu.

7. Select the Location/GPS tab.

Tip If the Sprint SmartView software is currently open and NMEA is currently 
enabled, you can verify that the selected port is functioning properly by 
clicking the Scan button. The words “GPS device found” should appear next to 
all three of the ports identified in step 1.
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8. Click Configure GPS Applications. The GPS Applications Window appears.

9. Click the Add button. The Application Configuration window appears.

10. In the Profile Name box, Type “Microsoft Streets & Trips 2008.”

11. Enter the location of the Streets & Trips program file (Streets.exe) in the File box. If you 
installed Streets & Trips in the default location, it’s at C:\Program Files\Microsoft 
Streets & Trips\Streets.exe. 

— or — 

Click the Browse button to browse for the file on your hard drive. When you have 
found the file, select it and click OK.

12. Type “COM” plus the number of the port you selected in step 4 in the Parameters box 
(for example, COM33).

13. Click OK.

You should now be able to launch Streets & Trips by selecting “Microsoft Streets & Trips 
2008” from the GPS Applications Menu (new interface) or by clicking the Streets & Trips 
icon in the GPS Bar (classic interface). 
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Section 12A

What is a Virtual Private Network?

A Virtual Private Networks (VPN) is a private networks that can be accessed over a public 
backbone network (like the Internet) without compromising the privacy of the VPN. Typically, 
VPNs maintain their privacy by forming secure (encrypted) “tunnels” directly to users who 
access them. For example, a company might set up a VPN for its employees to access their 
corporate network securely when they are away from the office.

The software responsible for forming the tunnel with the private network is called a VPN Client. 
Because the VPN Client and the private network exchange data in an encrypted format, no one 
on the public network over which this information passes can access it.

Section 12B

Supported Clients

Although Sprint SmartView is not a VPN Client itself, it can automate the launching of your VPN 
Client software when needed. Sprint SmartView has been tested with the following VPN Clients 
and even automates certain tasks for these clients:

● Microsoft

● Cisco
● Nortel

● Checkpoint

● NetMotion
Sprint SmartView can also launch other VPN Clients, but may require more manual 
configuration to do so. 
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Section 12C

Configuring a VPN Connection

As with any other secure network, accessing a VPN requires some security-related 
configuration. Perform these steps:

1. Consult the administrator of the VPN you wish to access. The administrator will 
provide you with VPN Client software and instructions for establishing VPN 
connections.

2. If the VPN Client software is not already installed on your system, install it now. 
(Microsoft's VPN Client is pre-installed on most versions of Windows).

3. Follow your administrator’s instructions for setting up a VPN Login Profile.

4. Access the VPN tab by selecting the Settings option in the Tools menu and then 
clicking the VPN tab.

5. If the VPN Client software you are using is supported by Sprint SmartView, select Use 
existing VPN Profile. Then, specify the client software and the Login Profile that you 
want to use.

If the VPN Client software you are using is NOT supported by Sprint SmartView, select 
Use Third Party VPN Client. Then, click the Browse button to specify the location of 
the client software that you are using.

6. Click the OK button to exit the Settings window.

Once your VPN Settings have been configured, there are two ways to start your VPN 
connection.

● Automatically start your VPN Session upon connection by configuring a Network 
Profile to do so.

● Manually launch the VPN Client by clicking the VPN button in Sprint SmartView’s 
main window.
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Section 12D

Automatically Launching a VPN Connection

You can configure a network profile to automatically launch your VPN Client and log into a VPN 
once the connection to the public network. Follow these steps:

1. If you have not already done so, configure the connection settings for the VPN you wish to 
connect to. (See “Configuring a VPN Connection” on page 106).

2. Open the Network Profiles window by selecting Profiles from the Tools menu.

3. In the left pane, select the profile for which you want to automate VPN connections.

4. Click the Edit button. The Edit Profile window for the selected profile appears.

5. If the General tab is not already selected, select it now.

6. Check the Auto Launch box.

7. Click OK to exit.

Tip If you want your VPN Client to be launched automatically with all (or most) of the new 
profiles you create, consider checking the Auto Launch Box on the VPN tab of the 
Settings window. This configures the default behavior of all newly created profiles.
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Section 13A

What is a Network Profile?

A network profile is a saved configuration for connecting to a particular network. Some profiles, 
such as the profile used to establish a Sprint Mobile Broadband connection, are predefined. 
Additional network profiles for other types of connections can be created in the Network Profiles 
window.

Network profiles have the following advantages:

● You can configure Sprint SmartView to automatically connect to a network profile 
whenever the associated network is available.

● If the last network you connected to is not available, the Sprint SmartView software uses 
the priorities of all defined network profiles to select a network to connect to, regardless of 
whether it is in automatic or manual connection mode. In manual mode, the selected 
network is presented as the default for manual connection. This allows the same easy, 
one click connection to an alternate network. 

● You can automate steps in the connection process, such as entering an encryption key 
or logging into a VPN, so that you don't have to perform these actions each time you 
connect.

Moreover, you must have a profile for the following:

● Network profiles are required to connect to closed WiFi networks. See “Accessing a 
Closed Network” on page 61.

● A network profile is required to connect to a Mobile Broadband Network (Sprint 
SmartView creates one for you automatically when you connect a Mobile Broadband 
device).
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Section 13B

The Network Profiles Window

Network profiles can be added and configured in the Network Profiles window. To access 
the Network Profiles window, select Profiles from the Tools menu.

Network Profile Priority

In the Network Profiles window, profiles are listed in order of priority. When selecting a 
network to connect to, Sprint SmartView will go down the list from top to bottom, selecting 
the first network profile for which all of the following are true.

● The network described by the profile is available.

● You have a device capable of connecting to the network connected to your computer 
and ready.

● The Connection Options field on the General tab in the profile's configuration is set 
to either “Automatic” or “Prompt.”

● The profile is not “Other Connections” (see below).

Profile priority also determines when Sprint SmartView will automatically switch from one 
network to another. If you are connected to one network and a higher priority network 
becomes available, Sprint SmartView will switch to the higher priority network.
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Changing Profile Priority 
To change the priority of a specific profile, select the profile whose priority you would like to 
change. Then, click the Up button or the Down button to move the profile up or down the list.

“Other Connections”
Unlike the rest of the items in the network profiles list, “Other Connections” is not a network 
profile. It is simply a placeholder for all network connections of types that are not managed by 
the Sprint SmartView software. The placement of this item in the list determines how high 
priority these “other” connections should be considered. If “Other Connections” appears higher 
in the list than your current connection and you connect a network of “other” type to your 
computer, Sprint SmartView will automatically shut down its current (lower priority) connection. 

For example, if you had a local network connection of a type that is not managed by Sprint 
SmartView and you wanted Sprint SmartView to shut down any wireless connections it 
manages whenever you connected to your local network, you would simply move “Other 
Connections” above all your wireless network profiles in the list. If, on the other hand, you did 
not want Sprint SmartView to disconnect in this situation, you could leave it at the bottom of the 
list.

Note You can specify which types of networks are included in the “Other Connections” 
group in the Hardware tab of the Settings window.
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Section 13C

Creating a Profile for a WiFi Network

Perform these steps to create a WiFi network profile.

1. Select Profiles from the Tools menu. The Network Profiles Window will now be 
displayed.

2. Select Add New Profile from the Settings menu. A list of network profile types now 
appears.

3. Select WiFi.
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4. Click the Add button to bring up the first page of the wizard used to create WiFi network 
profles.

5. In the SSID Field, enter the broadcast name of the network to which you will be 
connecting. Note that the name entered here must match the SSID (Service Set IDentifier) 
used by the network exactly.

6. If the network is a Closed network, check the This is a non-broadcast network box.

7. If the network whose profile you are configuring does not use WEP or WPA encryption, 
leave the Enable data encryption box unchecked.

—or—

If the network uses WEP or WPA encryption, check the Enable data encryption box and 
configure the WiFi Data Encryption Settings as explained in “Configuring WiFi Data 
Encryption” on page 115.
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8. Click the Next Button. The General page appears (see page 132).

9. Configure the settings in the General page as desired and then click Finish.
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Configuring WiFi Data Encryption

1. Contact the administrator of the network you wish to access to obtain any necessary 
information such as the security method used or the encryption keys required. 

2. Check the Enable data encryption box.

3. Select the appropriate Authentication method for this network. Supported authentication 
methods include the following:

� None: For an unencrypted network.

� WEP-Open (Normal Method): This is the standard WEP encryption method.

� WEP-Shared: This variant of WEP uses an encryption key that is pre-shared between 
the parties of the connection.

� WPA (TKIP or AES): If you select this method, you will need to configure 802.1x 
Authentication using the fields in the lower half of the page.

� WPA-PSK (TKIP or AES): You will need to enter your pre-shared key in the “Network 
Key” fields.

� WPA2 (TKIP or AES): If you select this method, you will need to configure 802.1x 
Authentication using the fields in the lower half of the page.

� WPA2-PSK (TKIP or AES): You will need to enter your pre-shared key in the “Network 
Key” fields.

4. If you selected WEP-SHARED or one of the WPA or WPA2 methods that have “PSK” in 
their names, you must enter the encryption key for this network in Network Key and 
Confirm Network Key fields.

If you selected one of the WPA or WPA2 methods that don't have “PSK” in their names, 
you must configure 802.1x Authentication. Follow these steps to enable 802.1x 
Authentication when connecting to this network:

a. Check the Enable 802.1x Authentication box.

b. Select the EAP Type from the EAP Type dropdown menu.

c. Click the Properties button to configure the settings for the selected EAP type.

If you selected “WEP-OPEN” as the authentication method, you can either enter an 
encryption key in the Network Key fields or fill out the 802.1x Authentication section.

Note The WPA methods listed above will only be displayed if your WiFi adapter supports 
WPA security.
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Section 13D

Creating a Profile for a Dialup Network

Follow these steps to create a dialup network profile:

1. Select Profiles From the Tools menu. The Network Profiles window will now be 
displayed.

2. Select Add New Profile from the Settings menu. A list of network profile types now 
appears.

3. Select Dialup. 

4. Click Add. The first page of the wizard used to create Dialup network profiles appears 
(see page 123).

5. By default, access telephone numbers are assumed to be local (i.e. you do not need 
to dial the area code or other prefix prior to the number itself). If this number requires 
that you dial the area code or you need to dial a special prefix prior to dialing this 
number, check the Use dial properties box and then click the Dial Properties button 
to configure the appropriate settings.

6. If the Area code must be dialed before this number, enter it now.

7. Enter the local portion of the number to be dialed (the portion that follows the area 
code) in the space marked Phone number.

8. Select the Country in which the number to be dialed is located.

9. Click Next. The General page appears (see page 132).

10. Configure the settings in the General page as desired and then click Finish.
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Section 13E

Creating a Profile for an Ethernet Network

Follow these steps to create an Ethernet network profile.

1. Select Profiles from the Tools menu. The Network Profiles window will now be displayed.

2. Select Add New Profile from the Settings menu. A list of network profile types now 
appears.

3. Select Ethernet.

4. Click Add. The first page of the wizard used to create Ethernet profiles appears (see page 
121).

5. In the fields provided, enter the criteria that Sprint SmartView should use when attempting 
to match this profile to Ethernet networks that you connect to. You must enter a value in at 
least one of these fields (it does not matter which). Additional fields are optional.

6. When you are finished, click Next to continue to the IP Properties page.

7. The default selections on the IP Properties page are correct for most networks. If, however, 
this particular network requires specific IP address and/or DNS server settings, you can 
specify them here.

8. Click Next. The General page appears (see page 132).

9. The settings on the General page are largely personal preference. Configure these as 
desired.

10. Click Finish.
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Section 13F

Automatic Profile Creation Settings

If you wish, Sprint SmartView can automatically create network profiles for each new WiFi 
network you successfully connect to. The setting that controls this can be found by 
selecting Automatic Profile Creation from the Settings menu in the Network Profiles 
window. Choose from the following options:

● Automatically save all networks that I connect to — Sprint SmartView will create a 
new profile for every new WiFi Network you successfully connect to.

● Prompt me before saving network settings — Sprint SmartView will ask you if you 
want to create a new profile each time you successfully connect to a new network.

● Allow manual input of network settings only — Sprint SmartView will not 
automatically create network profiles.

Section 13G

Editing a Network Profile

You can edit all settings for network profiles you have created yourself and all of settings for 
profiles that were created automatically for you when you connected to a WiFi network. A 
reduced set of parameters will be available for modification in profiles that were created for 
you by Sprint.

1. Select Profiles from the Tools menu. The Network Profiles window appears.

2. Select the profile you wish to edit in the left pane of the window.

3. Click the Edit button. A tabbed interface showing all the user-editable settings of the 
selected profile appears. Depending on the type of profile you are editing, the 
following tabs may be displayed:

� WiFi (see page 120)

� GPRS (see page 125)

� Ethernet Network Name (see page 121)

� Dialup (see page 123)

� IP Settings (see page 127)

� General (see page 132)

4. Make the desired changes.

5. Click the OK button when you are finished.
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Section 13H

Deleting a Network Profile

Follow these steps to delete a profile from the Network Profiles window:

1. Select Profiles from the Tools menu. The Network Profiles window will now be displayed.

2. Select the profile that you want to delete from the list in the left pane of the window.

3. Click Remove. A prompt that asks if you are sure you want to delete this profile appears.

4. Click Yes to confirm that you want to delete the profile.

Note You can delete any profile that you created or that was created automatically for you 
when you connected to a WiFi network successfully. You cannot delete network profiles 
that were created for you by Sprint.
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Section 13I

Profile Properties: WiFi

The WiFi page contains the security settings for WiFi network profiles.

● The version of this window pictured on the left below appears when creating a new 
profile. 

● The tabbed version on the right appears when editing an existing profile. 

Although the window controls vary, the actual parameters included are identical for both 
versions. 

Follow these steps to configure WiFi network security:

1. In the SSID field, enter the name broadcast by the network for which you are creating 
a profile. The name entered here must match the SSID (Service Set IDentifier) used by 
the network exactly.

2. If this is a closed network, check This is a non-broadcast network (closed).

3. If the network does not use WEP or WPA encryption, leave Enable data encryption 
unchecked.

—or—

If the network does use WEP or WPA encryption, check Enable data encryption and 
configure the WiFi data encryption settings. (See “Configuring WiFi Data Encryption” 
on page 115).
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Section 13J

Profile Properties: Ethernet Network Name

The Ethernet Network Name page contains the Ethernet-specific settings for network profiles. In 
the fields provided, enter the criteria that Sprint SmartView should use when attempting to 
match this profile to Ethernet networks that you connect to. 

● The version of this window pictured on the left below appears when creating a new 
profile. 

● The tabbed version on the right appears when editing an existing profile. 

Although the window controls vary, the actual parameters included are identical for both 
versions. 

You must enter a value in at least one of these fields (it does not matter which). Additional fields 
are optional.

DNS Suffix
The name of the DNS Domain to which this network belongs. For example, Sprint.com.

Note Some versions of the Sprint SmartView software do not support creating and editing 
Ethernet network profiles. I
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IP Subnet
Specify possible IP addresses that may be assigned to your Ethernet Interface when you 
are connected to this network. To specify a range of addresses, enter only the beginning of 
the IP Address. For example:

172 The profile will be used if the Ethernet Interface is assigned any IP address that 
begins with 172.

172.77 The profile will be used if the Ethernet Interface is assigned any IP address that 
begins with 172.77

172.77.64 The profile will be used if the Ethernet Interface is assigned any IP address that 
begins with 172.77.64

172.77.64.5 The profile will be used only if the Ethernet Interface is assigned 172.77.64.5

NT Domain
Specify the Windows NT Domain to which you will belong when attached to this network.

Must match all associations
● When this box is checked, a network to which you are connecting must match ALL of 

the values entered above in order to use this profile. Values that are left empty above 
will be treated as wildcards (anything matches).

● When this box is NOT checked, only one matching value must be found. 
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Section 13K

Profile Properties: Dialup

The Dialup page is used to specify the number to dial in order to access a specific dialup 
network from a specific location. 

● The version of this window pictured on the left below appears when creating a new 
profile. 

● The tabbed version on the right appears when editing an existing profile. 

Although the window controls vary, the actual parameters included are identical for both 
versions. 

Follow these steps to specify the number to dial. 

1. By default access telephone numbers are assumed to be local (i.e. you do not need to 
dial the area code or other prefix prior to the number itself). If this number requires that 
you dial the area code or you need to dial a special prefix prior to dialing this number, 
check the Use dial properties box and then click the Dial Properties button and then 
configure the appropriate settings as described in “Dial Properties” on page 70. 

2. If the Area code must be dialed before this number, enter it now.

3. Enter the local portion of the number to be dialed (the portion that follows the area code) 
in the space marked Phone number.

Note Some versions of Sprint SmartView software do not support creating and editing Dialup 
network profiles. 
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4. Select the Country in which the number to be dialed is located.
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Section 13L

Profile Properties: GPRS

This GPRS page contains the basic settings for GSM network profiles. 

● The version of this window pictured on the left below appears when creating a new 
profile. 

● The tabbed version on the right appears when editing an existing profile

Although the window controls vary, the actual parameters included are identical for both 
versions.

Service
The name of the network for which you are creating this profile. It is not editable.

Service Type
Select the type of service provided by this network. Most GSM Networks now provide packet 
data service. So, the correct selection here would be “Packet.” A few networks, however, may 
still be using the older GSM/CSD for Data Connections. In this case, “Circuit” would be the 
correct selection. 

Note If you have selected a network that only provides one type of service, this menu will 
only include the type that is provided by the selected network.
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Dialed Number
This is the telephone number that your Mobile Broadband device must dial in order to 
connect to this network. In most cases, the dialed number for the selected network will have 
been pre-entered for you (and will not be editable). However, if you are creating a custom 
profile, you must enter the appropriate number here. If you do not know the appropriate 
information for this network, contact the network provider.

Access Point Name
This is the name of the Wireless Access Point (WAP) that your GSM device communicates 
with when connected to this network. In most cases, the Access Point Name for the 
selected network will have been pre-entered for you (and will not be editable). However, if 
you are creating a custom profile, you must enter the appropriate number here. If you do not 
know the appropriate information for this network, contact the network provider.
Section 13L, Profile Properties: GPRS        126



Section 13M

Profile Properties: IP Settings

The IP Settings page allows you to configure the Internet Protocol (IP) addressing to be used 
with a particular profile.

● The version of this window pictured on the left below appears when creating a new 
profile. 

● The tabbed version on the right appears when editing an existing profile.

Although the window controls vary, the actual parameters included are identical for both 
versions. 

Profile IP Address
The settings in the top group specify the IP address that your system will use when connected 
to this network. The default selection, Obtain IP address automatically, instructs Sprint 
SmartView to ask the network to assign it an appropriate address each time it connects. This is 
the correct setting for most network profiles.

However, if the network does not support automatic address assignment, you can enter 
appropriate values manually by selecting Use the following IP address. Contact the 
administrator of the network whose profile you are configuring to obtain appropriate values for 
these fields.
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Profile DNS Server
The settings in the lower group specify the address of the name server that your system 
should use to translate names (for example, “Sprint.com”) to numerical addresses when 
connected to this network. The default selection, Obtain DNS server address automatically, 
instructs Sprint SmartView to ask the network to provide the address of a name server each 
time it connects. This is the correct setting for most network profiles.

However, if the network does not support automatic DNS server assignment, you can enter 
appropriate values manually by selecting Use the following DNS server address. Contact 
the administrator of the network whose profile you are configuring to obtain appropriate 
values for these fields.

Alternately, click Advanced to configure detailed settings for DNS and WINS Servers.

Advanced
Clicking Advanced opens the Advanced IP Settings window. This window allows you to 
configure advanced settings pertaining to naming services and protocols to be used with a 
particular network profile. There are three tabs in this interface:

● DNS (see page 128)

● WINS (see page 130)

● Protocols (see page 131)

Advanced IP Settings: DNS Tab

The DNS tab in the Advanced IP Settings window allows you to configure the advanced 
settings pertaining to Domain Name Server usage.
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DSN server addresses, in order of use
This is a list of DNS Servers that may be used. The first listed will be tried first. The second 
server listed will be used if the first is not available, etc. To add a server to the list, click Add and 
then enter the IP address for that server. If you wish to change the order in which servers are 
listed, use the arrows on the right.

Append primary and connection specific DNS suffixes
Selecting this option specifies that when attempting to resolve an unqualified DNS name, your 
computer will send two different name resolution queries:

● The first query it sends is based on the “Domain” portion of your computer's name 
(which can be found by clicking on the System Icon in the Control Panel). So, if the 
computer is attempting to resolve the name “pc21” and the Domain portion of your 
computer's name was “mycompany.com,” the first query sent would be for 
“pc21.mycompany.com.”

● The second query sent is based on the DNS Suffix entered in DNS suffix for this 
connection (see next page). So, if you entered “sales.mycompany.com” in that space, 
your computer would also attempt to resolve “pc21.sales.mycompany.com.” This query is 
only sent if a DNS Suffix is entered in the space provided.

The local setting is used only if the associated group policy is disabled or unspecified.

Append parent suffixes of the primary DNS suffix
Checking this box specifies that your computer should also send queries based on the parent 
domains in your computer’s name (up to the second level domain). For example, if your 
computer is attempting to resolve the name “pc21” and its own name includes the domain 
named “us.sales.mycompany.com,” it would query for “pc21.mycompany.com” and 
“pc21.sales.mycompany.com” in addition to the standard query for 
“pc21.us.sales.mycompany.com.”

Append these DNS suffixes (in order)
Selecting this option specifies that when attempting to resolve unqualified DNS Names, your 
computer will formulate a query based on each of the domains listed in the box directly below 
this option. For example, if your computer is attempting to resolve the name “pc21” and the 
domains “sales.mycompany.com” and “mycompany.com” appear in the list, your computer will 
query for “pc21.sales.mycompany.com” and “pc21.mycompany.com.”

The local setting is used only if the associated group policy is disabled or unspecified.

DNS suffix for this connection
If you wish to specify a DNS suffix for this connection, enter it here. 

Note If you enter a DNS suffix here, it will override any suffix assigned dynamically by a 
DHCP server. The local setting is used only if the associated group policy is 
disabled or ignored.
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Register this connection’s addresses in DNS
Checking this box specifies that the computer should attempt to dynamically register this 
connection’s IP Address (through DNS) using the full computer name specified on the 
Computer Name tab (available under System in the Windows Control Panel). The local 
setting is used only if the group policy is disabled or unspecified.

Use this connection’s DNS suffix in DNS registration
Specifies whether DNS dynamic update is used to register the IP addresses and the 
connection-specific domain name of this connection. The connection-specific domain 
name of this connection is the concatenation of the computer name (which is the first label 
of the full computer name) and the DNS suffix of this connection. The full computer name is 
specified on the Computer Name tab (available under System in the Windows Control 
Panel). If Register this connection's addresses in DNS is checked, this registration is in 
addition to the DNS Registration of the full computer name. The local setting is used only if 
the associated group policy is disabled or ignored.

Advanced IP Settings: WINS Tab

The list of WINS Servers on the WINS tab of the Advanced IP Settings window is used to 
resolve NetBIOS Names (typically used by Windows Workgroups). To add a server to the 
list, click the Add button and then enter the IP address of the desired server.
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Advanced IP Settings: Protocols Tab

The Protocols tab of the Advanced IP Settings window lists additional protocols that may be 
used with this connection. Check the protocols you wish to use.
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Section 13N

Profile Properties: General 

The General page contains settings that apply to all types of network profiles. 

● The version of this window pictured on the left below appears when creating a new 
profile. 

● The tab version on the right appears when editing an existing profile. 

Although the window controls vary, the actual parameters included are identical for both 
versions.

Profile Name
The name entered here will be displayed in the Network Profiles window and Sprint 
SmartView’s main window.

Note Some of the options pictured on this page may not be available if you are editing a 
profile created for you by Sprint.
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Connection Options
This setting controls what Sprint SmartView will do when it detects the network to which this 
profile applies. Select one of the following options:

● Automatic — Sprint SmartView will automatically connect to this network whenever it is 
detected.

● Prompt me — Sprint SmartView will ask you whether to connect to this network each time 
the network is detected.

● Manual — You must manually initiate connections to this network (either by using the 
controls in the main window or by selecting it in the Network Profiles window and then 
clicking Connect). Sprint SmartView will not connect to this network automatically.

Auto Launch
Check this box if you would like to automatically launch your VPN client software when you 
establish a connection to this network.

Enable Application Launcher
If this box is checked, Sprint SmartView will launch selected applications whenever it 
establishes a connection to this network. For an application to be launched in this manner, the 
following must also be true:

● The application must be listed on the App Launcher tab of the Settings window.

● The Launch Options field in the Monitor Details window (see page 86) must be set to 
either “Prompt” or “Auto.”

If this box is not checked, these applications will not be launched.

Disable IE’s manual proxy settings on connect
If you normally connect to the Internet through a proxy server (this is common on corporate 
LANs), you may experience difficulty connecting to the Internet with Internet Explorer when you 
are traveling. This is because Internet Explorer is trying to connect through a proxy server that is 
on your home network rather than on the network to which you are connected.

If this is the case, you can check this box to disable proxy server settings while you are 
connected using this profile.

Launch browser window on connect
Check this box to automatically launch your browser each time you connect to this network. If 
you want the browser to start at a particular Web page each time you connect to this network, 
enter the address for that Web page in the Start URL box.
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Section 14A

Introduction

The Settings window allows you to configure how Sprint SmartView behaves, including how it 
connects to networks, the sounds it produces and when it retrieves updates.

To access the Settings window:
� Select Settings in the Tools menu.

Section 14B

The App Launcher Tab

Applications listed on this tab will appear in the Applications Menu (new interface) and the 
Application Bar (classic interface). In addition to adding and removing applications from the list, 
you can specify whether each application will be automatically launched when you connect 
and whether you want to automatically disconnect when a particular application is shut down.

The App. Launcher tab is covered in depth in Chapter 10, “The Application Launcher”.”
135        Section 14A, Introduction



S
m

ar
tV

ie
w

 S
et

tin
gs
Section 14C

The Client Tab

The Client tab contains general settings for the Sprint SmartView Software. 

User Interface is always on top
When this box is checked, Sprint SmartView will always appear on top of other application 
windows.

Enable Splash screen
If this box is checked, Sprint SmartView displays a splash screen while it starts up. 

Automatically run this application on machine startup
When this box is checked, Sprint SmartView will be launched automatically each time you 
start your computer.
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Display Connection Timer
When this box is checked (default), a timer will be displayed in the main window, showing how 
long the current connection has been established. When this box is unchecked, the timer will 
not be displayed.

Use this as my default WiFi management utility
When this box is unchecked, WiFi functionality is disabled and does not appear in Sprint 
SmartView's user interface.

Transparency
This menu allows you to increase the transparency of Sprint SmartView’s main window.

Zoom
This menu lets you stretch the main user interface up to twice its default size.

Reset all warning messages
By clicking Reset, you can restore all warning messages that you may have disabled to their 
default display settings.
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Section 14D

The Hardware Tab

The Hardware tab is new to this software release. It is a combination of the Rules Engine, 
WiFi, and Mobile tabs that were present in previous releases.

The following items can be found on this tab:

The Device List
This four column table takes up most of the tab's area. It is a list of all the devices 
connected to your computer that may be used to establish network connections. Among 
other things, you can do the following here:

● You can enable and disable individual devices.

● If you have multiple devices of the same type, you can choose which one to use.

● You can configure extended properties for Mobile Broadband and Dialup devices
 For more information, see The Device List.
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Allow simultaneous connections
If this box is checked, Sprint SmartView will allow you to establish more than one connection at 
a time (for example, you could be connected to both WiFi and Mobile Broadband concurrently).

If this box is NOT checked, Sprint SmartView will prompt you to disconnect before allowing you 
to establish a second connection.

Prompt before switching connections
When in automatic connection mode, the Sprint SmartView software can automatically switch 
to a higher priority network if one becomes available. However, since the original connection is 
shut down once the new connection is fully established, this has the potential to disrupt any 
activity that was relying on the original connection. 

If this box is checked, Sprint SmartView will prompt you for permission to switch networks 
before it actually does so.

The Profiles Button
Click this button to open the The Network Profiles window.

The Device List

The device list is a four-column table that appears at the top of the Hardware tab of the Settings 
window. It is primarily used to select and configure connected devices.

Devices Column
This column lists all of the network access devices installed on your computer, grouped by the 
connection technologies they use. Each technology type heading is followed by the device 
names of the specific devices of that type that are installed on your computer. The technology 
types are:

● Mobile Devices
● ISDN Devices

● WiFi Devices

● Analog Dial-up Devices (Modems)
● Ethernet Devices

● Other Devices

Selected Column
This column allows you to specify which devices should be used to connect. The choices for 
this column are:

Automatic: Sprint SmartView will automatically choose the best device for this technology type.

Note The behavior of this interface is significantly different for devices listed under the 
Other Devices heading. See “Other Devices” on page 140 for more information.
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Manually Selected: Allows you to manually select the device to be used. After selecting this 
option, check the box next to the device you wish to use.

Disabled: This option is useful when you are using a multi-function device that can only use 
one wireless mode at a time. For example, you may have a WiFi/Mobile Broadband network 
adapter that can't access both types of network at the same time. When using such 
adapters, you may have to temporarily shut down Sprint SmartView's use of one of these 
functions when you want to use the other technology.

Status Column
This column identifies the operational status of the device (on or off).

Property Column
If there are additional properties that may be configured for a specific device type, a button 
labeled with three dots will be displayed in this column. Click this button to open a pop-up 
window which provides additional configuration options for the device. There are three 
versions of this pop-up window:

● CDMA (see page 141)

● GSM (see page 144)

● Dialup (see page 145).

Other Devices
Unlike the categories in the device list, “Other Devices” does not configure the behavior of 
devices Sprint SmartView uses to establish connections. Instead, this group lists the 
network devices installed on your computer that are NOT supported by Sprint SmartView. 
Although Sprint SmartView cannot use such devices to establish connections, it can detect 
when a device in this category has established a connection and (if you desire) shut down 
its own connections when this occurs. 

If you want Sprint SmartView to monitor the connection status of a device in this group, 
check the box in the Selected column. Connections for all checked devices will be included 
in the Other Connections group in the Network Profiles window. See Profile Priorities for 
more information on the Other Connections group.

The Automatic/Manual/Disabled dropdown menu at the top of the Other Devices group 
determines the default state of the checkbox for newly-detected device. 

● If the dropdown is set to Automatic, new devices added to the other group will be 
checked by default.

● If the dropdown is set to Manual, new devices will be unchecked by default. 

Note If you click the button next to the Mobile Devices heading, you will get either the GSM 
or the CDMA version of the popup window, depending on which type of device is 
currently selected.
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Device Property Window: CDMA Version

The CDMA version of the Device Property window contains four sections which are used to 
configure the behavior of CDMA Mobile Broadband devices connected to your computer. the 
functionality of the sections in this window are described in the following paragraphs.

Roaming Selection
Its options in this group dictate whether Sprint SmartView will attempt to connect to a roaming 
network. Consult your service agreement for more information about roaming service and any 
charges that such service might incur. You can choose one of these options:

● Auto — to connect to the Sprint National Network when it is available, using roaming 
networks only when Sprint service is not available.

● Sprint Only — to connect only to the Sprint Nationwide PCS Network. It will never connect 
to other networks.
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Use the Roam Guard pull-down menu to specify whether you would like Sprint SmartView 
to display a warning message when you are about to connect to a roaming network for 
which there may be additional roaming charges.

● When Always Ask is selected, Sprint SmartView will always display the warning 
message when connecting to a roaming network.

● When Never Ask is selected, Sprint SmartView will never display the warning 
message.

● When Default is selected, Sprint SmartView will display the warning message only 
when connecting to an international roaming network.

Mode
This menu allows you to specify which technology will be used to establish Mobile 
Broadband data connections.

● Automatic: Sprint SmartView will automatically select the best fit for your Mobile 
Broadband device. 

● CDMA 1xRTT: Comparable to a Sprint Vision® connection. 

● CDMA EVDO: Comparable to a Sprint Power Vision® connection.

Connection Type
This setting determines which software interface Sprint SmartView should use to 
communicate with your Mobile Broadband device. 

● NDIS allows more efficient communication with devices that support it.
● RAS is supported by more devices.

NDIS also has an automatic connection feature. See “Automatic Connection for NDIS 
Devices” on page 39 for more information.

Note Many Mobile Broadband devices support only one of these interfaces. If this is the case 
with your device, the interface that your device supports will be selected by default and 
you will not be able to change the selection.
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Device Configuration
This group of settings allows you to update the configuration files that actually reside on your 
Mobile Broadband device. Choose from the following options:

● Check Disable Service Updates to disable all updates to your device’s configuration. This 
item disables all the other items in the Device Configuration group and disables network-
initiated updates of the same information.

● Click Activate Device if the selected device has not yet been activated. This will initiate 
the device activation process. Note that this button will not be available if the selected 
device has already been activated.

● Click Update PRL to download the latest Preferred Roaming List. The Preferred Roaming 
List informs your device who Sprint's current roaming partners are. Keeping this list 
current ensures that your Mobile Broadband device will select networks with the most 
reasonable roaming fees.

● Click Update Profile to update the profile your device uses to establish connections.

● Click Update Firmware to download the latest version of your Mobile Broadband device's 
firmware (its onboard operating software).

Note This group of settings is only available for some Mobile Broadband devices and will 
be disabled for others.
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Device Property Window: GSM Version

The GSM version of the Device Property window is used to configure the behavior of GSM 
Mobile Broadband devices connected to your computer. The functions of the settings in this 
window are described in the following paragraphs.

Network Selection
This group’s settings control how Sprint SmartView selects which wireless network to 
connect to when you are travelling internationally.

● Auto instructs Sprint SmartView to automatically select the best network to connect to 
based on information provided by your wireless data service provider. In most cases, 
this will provide the best connection available. This option is strongly recommended 
for all but the most advanced users.

● Manual instructs Sprint SmartView to always connect to a specified network 
regardless of the availability of other wireless networks. This is useful if you know of a 
specific network that always provides you better service and you don’t mind 
occasional service outages when the specified network is unavailable.
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Mode
This menu allows you to specify which technology will be used to connect.

● 3G Only. Only connect via 3G technologies.

● GPRS Only. Only connect via 2G technologies.

● Automatic: Use the default behavior of your wireless device (note that this option only 
appears if your device has a default behavior).

Device Property Window: Dialup Version

The Dialup version of the Device Property window configures the behavior of both analog 
dialup devices (modems) and ISDN dialup devices (sometimes called “terminal adapters”). The 
version of the window contains two check boxes which allow you to select the method of 
initiating a connection.

Wait for dialtone
Check this box to have the modem wait for a dialtone before attempting to dial a number. This 
is useful if your phone line does not always produce a standard dial tone immediately. For 
example, some telephone networks temporarily alter the dial tone to signal that you have new 
voice mail. 

Display the last number dialed on startup
If this box is checked, the last access phone number that Sprint SmartView dialed will be used 
as a default for the next connection. If this box is not checked, there will be no number selected 

WARNING When manually scanning for networks, Sprint SmartView currently displays all 
mobile networks in the area, even those with which Sprint does not have roaming 
agreements. Some networks displayed may not allow you to connect. Others may 
charge you very high roaming fees. For this reason, manual network selection is not 
recommended for most users.
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by default. You must manually enter a number or select a dialup network profile each time 
you connect.
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Section 14E

The Location/GPS Tab

The Location/GPS tab lets you configure how Sprint SmartView locates nearby restaurants, 
banks, hotels, etc. using the Global Positioning System (GPS) in conjunction with Internet-based 
mapping and search services. 

Disable GPS on Device
Checking this box disables the GPS functionality on your Mobile Broadband device and 
removes all GPS-related menu items and buttons from Sprint SmartView’s user interface.

Note The settings on this tab will only be available if your Mobile Broadband Device 
provides GPS functionality.
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Do not show Privacy Consent Agreement for...
Checking any of these three items suppresses the display of the corresponding Privacy 
Consent Agreement. The first two of the privacy consent agreements listed in this space 
appear when you click the GPS Bar on the main user interface. You must accept both of 
these agreements in order to use any of Sprint SmartView's GPS functions. The third 
privacy consent agreement listed here appears when you click the yellow button in the 
lower-right corner of the GPS Bar. You must accept this agreement if you wish to use your 
GPS Receiver with third party GPS applications.

Automatically start GPS when a CDMA connection is established
If this box is checked, the GPS Bar will open and Sprint SmartView will begin acquiring 
GPS data automatically whenever you successfully connect to a CDMA Mobile Broadband 
Network.

Mapping Service Default
Lets you select which mapping and search service you want to use when searching for 
nearby restaurants, banks, etc.

GPS Mode
If your Mobile Broadband device supports multiple GPS modes, you can select which 
mode your device should use.

Configure GPS Applications
Click this button to open the GPS Applications window. This window can be used to add 
more application icons to the GPS Applications Menu (new interface) and the GPS Bar 
(classic interface). See “” on page 97 for more information. 

Test GPS
Click this button to test the GPS functions of your Mobile Broadband device by querying the 
device for your current location.

Note An indication of whether you have accepted each of these agreements is displayed 
immediately to the right.

Note Test results appear to the right. These data fields also appear on the GPS Bar. See “” 
on page 96 for their descriptions.
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Section 14F

The Sounds Tab

The Sounds tab lets you configure Sprint SmartView to play a sound when various events 
occur. You can also specify the sounds that Sprint SmartView plays. Check the Enable sounds 
box to enable this feature. Once the feature is enabled, check the box for an event you wish to 
associate with a sound, and then click Browse to select the sound file (Windows .WAV format) 
for that event. 

You can specify sounds for the following events:

Connected
Plays a sound when Sprint SmartView successfully connects to a WiFi Network.

Lost Connection
Plays a sound when Sprint SmartView disconnects from or loses its connection to a WiFi 
Network.

Hot Spot Connection
Plays a sound when Sprint SmartView associates with a WiFi hotspot.
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Section 14G

The Update Settings Tab

The Update Settings tab allows you to specify when updates to the Sprint SmartView 
software and its databases are made..

Automatically download and install
Select this option to have Sprint SmartView automatically download and install product 
updates at regular intervals (once a week). 

Prompt me to download and install
Select this option to have Sprint SmartView periodically prompt you to download and install 
product updates.

Manually download and install
Select this option if you want product updates to be downloaded only when you click the 
Update Now button below.

Note These updates are silent. You will not see the update wizard when updates are 
downloaded silently.
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Update Now
Click Update Now to have Sprint SmartView immediately check for available updates. If new 
updates are available, an update wizard will appear. This wizard allows you to choose which 
updates you want to download and install.

Apply Firmware Update
As part of its update process, Sprint SmartView can download updates to your Mobile 
Broadband device's firmware. Normally, such an update will be installed as soon as it is 
downloaded. In some cases, however, you can choose to defer the update's installation until 
later. Click Apply Firmware Update to install an update that you had earlier chosen to defer.
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Section 14H

The VPN Tab

The VPN tab specifies how Sprint SmartView accesses Virtual Private Networks. 

Selecting Do Not Use VPN disables Sprint SmartView's VPN functionality. Select this option 
if you do not plan to establish VPN connections.

You must choose one of the other two options and fill in the corresponding fields if you wish 
to do either of the following things:

● Connect to a VPN by clicking the VPN button (“classic” interface) or the VPN Icon 
(“new” interface) in the main window.

● Automatically log into a VPN when you connect to a specific network (see 
“Automatically Launching a VPN Connection” on page 107).

Use existing VPN profile
Select this option if the VPN Client software you will be using is supported by Sprint 
SmartView. Then, specify the supported VPN Client software and the Login Profile that you 
want to use. See “Supported Clients” on page 105 for more information on supported VPN 
Client software.
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Use third party VPN client
Select this option if the VPN Client software you will be using is not supported by Sprint 
SmartView, and then follow these steps:

1. Click Browse.

2. Select the program file to be launched.

3. Click Open. The path of the selected file should now appear in the Command Line box.

4. If your VPN Client software requires that additional parameters be included after the 
program filename on the command line, these may be entered in the Parameters box. 
Consult the documentation for your VPN Client to determine if such parameters are 
needed.

See “Supported Clients” on page 105 for more information on which VPN Client software is 
supported.

Auto Launch
Check this box if you want new Network Profiles created to automatically launch the VPN 
software specified above each time you connect. Note that this is only a default. You can 
change this setting for an individual profile by checking or unchecking the VPN Autolaunch box 
on the General tab of the settings for the desired profile. See “Automatically Launching a VPN 
Connection” on page 107 for more information.
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Section 15A

Event History Manager

The event history can be viewed from the Help menu in the Main Window. Click Help > Event 
History Manager to see events that have been logged (for example, connections, 
disconnections, errors). The window shown below will appear.

You can do the following in this window:

● Double-click on any item in the list to see more information about that event

● Use the options in the Filter by box to limit the events displayed to a particular date range, 
connection technology or event type.

● Click Export Log to save a copy of this log to a text file.

● Click Clear Log to delete all the logged events.
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Section 15B

WiFi Network Info

To view information about a WiFi Network you are currently connected to or about your 
current WiFi device, select WiFi Info from the Tools menu. This produces the window shown 
below.

Network Tab

IP Address
The Internet address your computer is using for the current WiFi network connection. 
Ordinarily, the address displayed here is assigned only for the duration of the current 
connection. It is most likely NOT permanently assigned to your computer.

Gateway
The address of the device that is responsible for routing all of the network traffic you send 
over the WiFi connection.
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DNS Server
The address of the server your computer is using to translate the textual Internet addresses 
used by human beings into the numerical addresses that computers use, and vice versa. For 
example, such a server would be used by your browser to discover that the numerical address 
of “Sprint.com” is 206.159.101.241.

DHCP Server
The address of the server that assigned your computer's network configuration for the current 
wireless connection.

WINS Server
The address of the server (if any) that your computer is using to find the names of computers 
on a Windows network. 

Activity
The number of packets of data that your computer has sent and received over the WiFi 
connection since it was established.
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Device Tab

Vendor Description
The name of your WiFi device, as reported by its onboard operating software.

MAC Address
The Hardware Address of the device. MAC (Media Access Control) addresses are 
pre-configured by the device's manufacturer and usually cannot be altered. These 
addresses are used for transferring data by hardware-level protocols such as Ethernet and 
802.11 (WiFi). Higher level protocols such as the TCP/IP Protocol Suite used by the Internet 
have their own addressing schemes, but still rely on the hardware-level protocol for the 
transfer of data between individual nodes on a network.

Driver Version
The version of the driver for this device that is currently installed on your computer.

Firmware Version
The version of the device's onboard operating software.
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Section 15C

The Mobile Info Window

To view information about your Mobile Broadband device and/or your current Mobile 
Broadband Connection (if any), select Mobile Info from the Tools menu. The window shown 
below will appear. 

Device Tab

Device Name
The name used internally by software applications to uniquely identify your Mobile Broadband 
device.

Note The information displayed in this window is provided by your Mobile Broadband Device 
and its drivers. If the device does not provide this information or the information 
provided is incorrect, this will be reflected in the displayed data.
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Device Description
The user friendly name of your Mobile Broadband device.

Manufacturer
The name of the manufacturer of your Mobile Broadband device. 

Modem Model
The model name of your Mobile Broadband device.

Revision
The revision field contains manufacturer-specific information about the version of your 
device. It may, for example, contain additional information about your device's model 
number or its firmware version.

ESN
Your Mobile Broadband device's Electronic Serial Number.

Technology
The type of Mobile Broadband device you are using (CDMA or GSM).

Firmware Version
The version of your Mobile Broadband device's onboard operating software.

Hardware Version
The version of your device's hardware.

Modem Port
The communications (COM) port that your Mobile Broadband device is currently attached 
to.

User Name
Your Network Access Identity (NAI), usually in the form of username@companyabc.com

Phone Number (MDN)
The telephone number of your Mobile Broadband device.

Home Carrier Name
The name of the wireless service provider that your Mobile Broadband device considers to 
be its “home” network.
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Home Carrier ID
The ID of the wireless service provider that your Mobile Broadband device considers to be its 
“home” network.

PRL Version
The version of the file on your device that contains the Preferred Roaming List.

MSID (IMSI_S)
Your Mobile Device's IMSI (International Mobile Subscriber Identity) code. The IMSI allows any 
mobile network to know the home country and network of the subscriber.

Network Tab

Network Name
The name of the mobile carrier you are currently connected to.
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System ID
The ID of the network to which your Mobile Broadband device is currently connected.

Connected
Indicates whether you are currently connected to a Mobile Broadband Network.

Roaming
Indicates whether you are currently connected to a Mobile Broadband Network that is not 
your “home” network.

MIP Error
The last Mobile IP Error Code reported by your Mobile Broadband device.

Signal Strength (dBm)
The strength of the signal being received from this network, expressed in dBm. 

Data Sent
The amount of data sent over this connection since it was established (in bytes).

Data Received
The amount of data received over this connection since it was established (in bytes).

IP Address
The IP Address you are using for the current Mobile Broadband Connection. Ordinarily, the 
address displayed here is assigned only for the duration of the current connection. It is most 
likely NOT permanently assigned to your computer.

Gateway Address
The address of the default gateway that has been assigned to your device.
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Section 15D

The WiMAX Info Window

To view information about your WiMAX device and the WiMAX network you are currently 
connected to (if any), select WiMAX Info from the Tools menu. The window shown below will 
appear.

Network Tab

IP Address
The Internet address your computer is using for the current WiMAX network connection. 
Ordinarily, the address displayed here is assigned only for the duration of the current 
connection. It is most likely NOT permanently assigned to your computer.

Gateway
The address of the device that is responsible for routing all of the network traffic you send via 
WiMAX.

DNS Server
The address of the server your computer is using to translate the textual Internet addresses 
used by human beings into the numerical addresses that computers use, and vice versa. For 
example, such a server would be used by your browser to discover that the numerical address 
of “Sprint.com” is 206.159.101.241.
163        Section 15D, The WiMAX Info Window



Tr
ou

bl
es

ho
ot

in
g 

To
ol

s

DHCP Server
The address of the server that assigned your computer's network configuration for the 
current WiMAX connection.

WINS Server
The address of the server (if any) that your computer is using to find the names used by 
computers in a Windows workgroup.

Activity
The number of packets of data that your computer has sent and received over the WiMAX 
connection since it was established.

Device Tab

MAC Address
The Hardware Address of the device. MAC (Media Access Control) addresses are pre-
configured by the device's manufacturer and usually cannot be altered. These addresses 
are used for transferring data by hardware-level protocols such as Ethernet or WiMAX. 
Higher level protocols such as the TCP/IP Protocol Suite used by the Internet have their own 
addressing schemes, but still rely on the hardware-level protocol for the transfer of data 
between individual nodes on a network.

Library Version
The version of the software interface of the device’s WiMAX chipset.

Firmware Version
The version of your WiMAX device's onboard operating software.
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Driver Version
The version of the driver for this device that is currently installed on your computer.

BaseBand Chip
The version of the chip in your WiMAX device that formulates the baseband WiMAX signal.

RF Chip Version
The version of the chip in your WiMAX device that modulates and multiplexes the baseband 
WiMAX signal for RF transmission.

Calibration Status
This indicates whether your WiMAX device has been calibrated.

Antenna Calib
This item is not currently reported by the Sprint SmartView Software.

Antenna Gain Diff
This item is not currently reported by the Sprint SmartView Software.

Tx Power Offset
This item is not currently reported by the Sprint SmartView Software.

MAC Version
This item is not currently reported by the Sprint SmartView Software.

The Advanced Button
Click this button to open the Advanced WiMAX Info window (see page 166).
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Advanced WiMAX Info

Clicking theAdvanced button on the Device page of the WiMAX Info window produces the 
Advanced WiMAX Info window (shown below). This window provides advanced information 
for troubleshooting the WiMAX airlink.

Rx Power
???

CINR
Carrier to Interference + Noise Ratio. This is an indication of how strong the desired signal 
is compared to any interfering signals and noise. A value of 27 as shown

BSID
Base Station ID. The ID of the base station you are currently connected to.

TX Power
???

Preamble Index
The Preamble Index of the WiMAX base station sector you are currently connected to.
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Section 15E

The Ethernet Info Window

To view information about your Ethernet device and the Ethernet network you are currently 
connected to (if any), select Ethernet Info from the Tools menu. The window shown below will 
appear. 

Network Tab

IP Address
The Internet address your computer is using for the current Ethernet network connection. 

Gateway
The address of the device that is responsible for routing all of the network traffic you send via 
Ethernet.

Note This menu option and the window it produces only appear on versions of the Sprint 
SmartView software that support establishing Ethernet connections. 
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DNS Server
The address of the server your computer is using to translate the textual Internet addresses 
used by human beings into the numerical addresses that computers use, and vice versa. 
For example, such a server would be used by your browser to discover that the numerical 
address of “Sprint.com” is 206.159.101.241.

DHCP Server
The address of the server that assigned your computer's network configuration for the 
current Ethernet connection.

WINS Server
The address of the server (if any) that your computer is using to find the names used by 
computers in a Windows workgroup.

Activity
The number of packets of data that your computer has sent and received over the Ethernet 
connection since it was established.
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Device Tab

Vendor Description
The name of your Ethernet device, as reported by its on-board operating software.

MAC Address
The Hardware Address of the device. MAC (Media Access Control) addresses are pre-
configured by the device's manufacturer and usually cannot be altered. These addresses are 
used for transferring data by hardware-level protocols such as Ethernet and 802.11 (WiFi). 
Higher level protocols such as the TCP/IP Protocol Suite used by the Internet have their own 
addressing schemes, but still rely on the hardware-level protocol for the transfer of data 
between individual nodes on a network.

Driver Version
The version of the driver for this device that is currently installed on your computer.

Firmware Version
The version of the device's onboard operating software.
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Section 15F

About Sprint SmartView

Select this item to display a window displaying version information for the Sprint SmartView 
software and the phone number for Sprint Customer Service.

Clicking the System Info button produces a window containing extensive information about 
your computer's configuration. This information may be useful to a Customer Service 
Representative should you need help in resolving a problem.
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Section 16A

Application Launch Issues

Application is not visible after launch

Sprint SmartView is designed to launch into the display state from which it was last exited. As 
such, it is possible that Sprint SmartView will launch directly to its minimized state, causing you 
to assume that it is not running.

Resolution
Look for a minimized Sprint SmartView in the Windows Task Bar. If Sprint SmartView is present, 
just click on it to return it to its normal state. 

Autolaunching of Sprint SmartView at Startup

Sprint SmartView installation can be configured to allow the application to automatically launch 
when a computer boots up or when a new user logs into the machine. This may (or may not) 
be the way you prefer it to behave.

Resolution
You can access the setting that controls this behavior by selecting Settings from the Tools 
menu and then choosing the Client tab. Check (or uncheck) the Automatically run this 
application on machine startup box to specify whether Sprint SmartView should be 
automatically launched.
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Section 16B

Device Issues

In some circumstances, Sprint SmartView will not be able to utilize a user's WiFi or Mobile 
Broadband device.

Disabled

WiFi and Mobile Broadband devices, like any other network adapter, can be disabled by 
Microsoft Windows. The status text in Sprint SmartView's Main Window will indicate when a 
device has been disabled.

Resolution
You can enable an attached wireless device by selecting Enable Mobile Broadband 
Adapter or Enable WiFi Adapter from the File menu. 

No Wireless Device Detected

Sprint SmartView will display No Wireless Device Detected if it cannot actively communicate 
with the wireless device. 

Resolution
Causes for this may include:

● Devices (such as phone handsets) that must be tethered to your computer with a 
data cable (such as USB), but are not currently properly connected. Make sure the 
cables for devices that require them are properly attached to both your computer and 
the device.

● External devices (such as phone handsets) that are not currently powered on. Make 
sure external devices are switched on. Make sure the batteries of battery-powered 
devices are charged. Make sure devices that must be plugged into an electrical outlet 
are plugged in.

● PC Card, USB, or Express Card devices that are not properly inserted. Make sure 
such devices are firmly seated in the appropriate slots.

Note On Windows Vista systems, these options may be unavailable (grayed out) at all 
times. This may be because of security restrictions in your Microsoft Vista security 
configuration. Running the application as an administrator may allow access to 
these options. Follow these steps:
 1. Close the Sprint SmartView software.
 2. Right click on the Sprint SmartView icon on the computer’s desktop. A short 

menu appears.
 3. Select Run As Administrator from the menu.
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● The wrong device is selected in the Hardware tab of the Settings window. Ordinarily, 
Automatic Selection should be specified in the Selected column. If Manual Selection is 
specified, verify that the selected device is the device you are trying to use. See “The 
Hardware Tab” on page 138 for more information.

● No driver or incorrect driver installed. Ensure that the latest drivers for the device are 
correctly installed according to the instructions of the device’s manufacturer.
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Section 16C

Numbered Errors

Error 67 

Your Sprint Vision User Name and/or Password may be incorrect. Possible causes include 
the following:

● Mobile Broadband device account credentials have changed.

● Mobile Broadband device is no longer provisioned for service.
● If the device is a handset, Phone As Modem Access has not been set up for the 

account.

Resolution
● Select Update Data Profile IOTA from the Tools menu. This instructs your Mobile 

Broadband device to update its provisioning information so that it may properly use 
Sprint Data Services. 

● Rerun the Activation Wizard. See page 10 for a tutorial on the Activation Wizard.
● Contact Sprint Customer Service to ensure that there are no problems with the 

account.

Error 131

Your Sprint Vision user name or password may be incorrect. Your Mobile Broadband 
device account credentials may have changed.

Resolution
● Select Update Data Profile IOTA from the Tools menu. This instructs your Mobile 

Broadband device to update its provisioning information so that it may properly use 
Sprint Data Services.

● Rerun the Activation Wizard. See page 10 for a tutorial on the Activation Wizard.
Section 16C, Numbered Errors        176



Error 619

A connection to the remote computer could not be established, so the port used for this 
connection was closed. Possible causes for this error include the following:

● Network resources are unavailable.

● Attempting to reconnect before your Mobile Broadband device has finished 
disconnecting from a previous call.

● Your Mobile Broadband device may be malfunctioning.

Resolution
● Wait 30 seconds, then try to connect again.

● Remove the Mobile Broadband device and reinsert it into the computer.

● Reboot the computer.

Error 628

The connection was terminated by the remote computer before it could be completed. Possible 
causes for this error include the following:

● Call was dropped due to poor signal.
● Call was dropped due to network congestion.

Resolution
● If indoors, move closer to a window, exterior wall or move to a higher level. Re-orienting 

the computer/wireless device may help as well.
● Wait 30 seconds, then try to connect again.

Error 633

The device is already in use or is not configured properly. Possible causes for this error include:

● There is a problem with some of the drivers installed for the wireless device.

● Another application such as a FAX program or PDA device software is attempting to use 
the port.

Resolution
● Shut down all FAX and PDA software and launch Sprint SmartView again. Examples of 

common applications that can cause this type of problem include: Palm Hotsync, 
Microsoft ActiveSync, and Blackberry Desktop Manager.

● Uninstall any other wireless device connection management software installed on the 
computer. 

● Re-install Sprint SmartView.
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Error 668 

The connection was dropped. Possible causes for this error include:

● Call was dropped due to poor signal.
● Call was dropped due to network congestion.

Resolution
● If indoors, move closer to a window, exterior wall, or a higher level. Re-orienting the 

computer/wireless device may help as well.

● Reboot the computer.
● Select Update Data Profile IOTA from the Tools menu. This instructs your Mobile 

Broadband device to update its provisioning Information so that it may properly use 
Sprint Data Services.

Error 678

The remote computer will not respond. Possible causes for this error include:

● Poor signal.

● Network resources are unavailable.

Resolution
● If indoors, move closer to a window or exterior wall or move to a higher level. Re-

orienting the computer/wireless device may help as well.

● Wait 30 seconds, then try to connect again.

Error 691

Access was denied because username and/or password supplied is invalid on the domain. 
Possible causes for this error include:

● Poor signal.

● Mobile Broadband device account credentials have changed.

Resolution
● If indoors, move closer to a window or exterior wall or move to a higher level. Re-

orienting the computer/wireless device may help as well.

● Reboot the computer.
● Select Update Data Profile IOTA from the Tools menu. This instructs your Mobile 

Broadband device to update its provisioning Information so that it may properly use 
Sprint Data Services.
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Error 692 

There was a hardware failure in the device. Possible causes of this error include:

● Wireless device is defective or broken.
● Problem with PC Card Slot, Express Card Slot, or USB Port. 

Resolution
● Close Sprint SmartView, reinsert the device, and launch Sprint SmartView again.

● Reboot the computer.

Error 718

PPP/Network Timeout. Possible causes for this error include:

● Poor signal.

● Network resources are unavailable.

Resolution
● If indoors, move closer to a window or exterior wall or move to a higher level. Re-orienting 

the computer/wireless device may help as well.

● Wait 30 seconds, then try to connect again.

● Reboot the computer.

Error 719

PPP termination by remote machine. Possible causes for this error include the following:

● Poor signal.

● Network resources are unavailable.

Resolution
● If indoors, move closer to a window or exterior wall, or move to a higher level. Re-

orienting the computer/wireless device may help as well.

● Wait 30 seconds, then try to connect again.

● Reboot the computer.
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Error 777

The connection attempt failed because the connecting device on the remote computer is 
out of order. Possible causes for this error include:

● Poor signal.

● Network resources are unavailable.

● There is a problem with one of the wireless device drivers.

Resolution
● If indoors, move closer to a window or exterior wall, or move to a higher level. Re-

orienting the computer/wireless device may help as well.

● Wait 30 seconds, then try to connect again.

● Close Sprint SmartView, reinsert the wireless device and launch Sprint SmartView 
again.

● Reboot the computer.

● Uninstall any other software that manages wireless connections (if any are present on 
the computer).

● Reinstall Sprint SmartView.
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 Frequently Asked Questions



Section 17A

General Questions

Why Does Sprint SmartView Shut Down Windows “Zero Config?”

“Zero Config” is the WiFi management utility built into Windows XP. Since Sprint SmartView also 
manages WiFi connections, these applications can interfere with one another. For this reason, 
Zero Config is shut down when you launch Sprint SmartView and restarted when you shut 
down Sprint SmartView.

If you would rather use Zero Config to manage WiFi connections, you must disable Sprint 
SmartView’s WiFi management by doing the following:

1. Select Settings from the Tools menu. The Settings window appears.

2. Select the Client tab.

3. Remove the check from the box labeled Use this as my default WiFi management utility.

4. Click the OK button.

How do I stop Sprint SmartView from launching every time I restart 
my computer?

Follow these steps:

1. Select Settings from the Tools menu.

2. Select the Client tab.

3. Remove the check from the Automatically run this application on machine startup box.

4. Click the OK button.

Note This procedure disables ALL of Sprint SmartView’s WiFi functionality and hides the WiFi 
Connections Interface entirely.
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Section 17B

WiFi Questions

Why Does Sprint SmartView Keep Scanning for WiFi Networks?

Sprint SmartView will continue to scan until it finds one or more available networks or hot 
spots. If it keeps scanning, there are most likely no WiFi networks or hot spots in the area.

“Closed” networks are a special case. Although Sprint SmartView can detect whether 
closed networks are in the area, it can’t actually identify (or connect to) individual closed 
networks without probing for these networks using their exact names. To enable this, you 
have to create a profile for the network you wish to connect to. See “Accessing a Closed 
Network” on page 61 for more information.

Why do I keep losing my connection?

This may be due to interference caused by other devices like cordless phones, microwave 
ovens, and other 2.4 GHz band devices. 

Why am I unable to connect to a network that I can see in Sprint 
SmartView?

Signal strength from the wireless Access Point may not be strong enough to allow reliable 
connections. It may not be a publicly available Access Point. Many companies or campuses 
will use wireless networking within their buildings, but will not grant public access.
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Section 17C

Device Issues

In some circumstances, Sprint SmartView will not be able to use your WiFi and/or Mobile 
Broadband device.

Disabled

WiFi and Mobile Broadband devices, like any other network adapter, can be disabled by 
Microsoft Windows. The status text in Sprint SmartView's Main Window will indicate when a 
device has been disabled.

Resolution
You can enable an attached wireless device by selecting Enable Mobile Broadband Adapter or 
Enable WiFi Adapter from the File menu. 

No Wireless Device Detected

Sprint SmartView will display “No Wireless Device Detected” if it cannot communicate with the 
wireless device. 

Resolution
Causes for this may include:

● Devices (such as phone handsets) that must be tethered to your computer with a data 
cable (such as USB), but are not currently properly connected. Make sure the cables for 
devices that require them are properly attached to both your computer and the device.

● External devices (such as phone handsets) that are not currently powered on. Make sure 
external devices are switched on. Make sure the batteries of battery-powered devices are 
charged. Make sure devices that must be plugged into an electrical outlet are plugged in.

● PC Card, USB, or Express Card devices that are not properly inserted. Make sure such 
devices are firmly seated in the appropriate slots.

● The wrong device is selected in the Hardware Tab of the Settings Window. Ordinarily, 
automatic selection should be specified in the “Selected” column. If Manual selection is 
specified, verify that the selected device is the device you are trying to use. See “The 
Hardware Tab” on page 138 for more information.

● No driver or incorrect driver installed. Ensure that the latest drivers for the device are 
correctly installed according to the instructions of the device’s manufacturer.
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Section 17D

GPS Questions

Terminology

GPS Bar = The interface that is described starting on page 93 

GPS = Global Positioning Systems

HEPE = Horizontal Estimated Position Error (equates to GPS accuracy)

NMEA = National Marine Electronics Association

LBS = Location-Based Services

BMF = Business Mobility Framework

IMQ = Idle Mode Query (Service Option 35) 

AFLT = Advanced Forward Link Trilateration

Questions About GPS Technology

What is GPS?
GPS Satellites transmit signals to equipment on the ground. GPS Receivers passively 
receive satellite signals, but do not transmit. There are various GPS standards for User Plane 
and Control Plane.

What is GPS User Plane?
It is the ability to execute GPS Requests at the subscriber level (that is, on your Mobile 
Broadband Device).

What is GPS Control Plane?
It is the ability to execute GPS Requests at the server level (that is, via the network).

What GPS mode options are supported?
GPS on a Sprint Mobile Broadband device works like any other GPS device. Sprint provides 
two types of GPS: GPS Basic and GPS Premium.

What is GPS Basic?
GPS Basic allows the Mobile Broadband device to do regular GPS for outdoor use. In this 
mode, the GPS receiver (device) requires an unobstructed view of GPS satellites (the sky), 
and like any other GPS device, often does not perform well within forested areas or near tall 
buildings. 
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Sprint GPS Basic is based on gpsOne® standards and uses LBS for the first fast GPS fix. GPS 
coordinate values are made available for applications via a local GPS NMEA communications 
port.

What is GPS Premium?
The GPS Premium option is not yet available at this time.

Is a GPS Subscription required?
For GPS Basic, no GPS subscription is required. For GPS Premium, a GPS subscription is 
required.

What is the difference between GPS Basic and GPS Premium?
GPS Basic is for outdoor use similar to regular GPS Device capability. GPS Premium is an 
enhanced GPS capability allowing the service to be used indoors and outdoors.

What is NMEA?
NMEA 0183 is a standard protocol, used by GPS Receivers to transmit data. NMEA Output is 
composed of various strings. Sprint Mobile Broadband devices support the following strings: 
$GPGGA, $GPRMC, $GPGSA, $GPGSV.

When does one need NMEA?
You only need NMEA when using a GPS Application that employs an NMEA output stream (see 
“What is a GPS Application?”, below). We recommend not activating the NMEA stream unless 
you are going to use it, to ensure the best possible data performance on your Mobile 
Broadband device.

What is Location-Based Service (LBS)?
LBS is used to provide enhanced local search functionality via the Internet.

What is Business Mobility Framework (BMF)?
BMF is an LBS infrastructure that allows GPS server-based solutions to request and obtain 
device location information.

What is enhanced local search?
It is a quick and easy method to run local search queries. This allows you to find locations and 
directions to locations/businesses via the Sprint SmartView Software. The enhanced local 
search uses LBS, thus allowing you to search for Sprint Nextel stores, hotels, restaurants, coffee 
shops, banks, etc. indoors and/or outdoors.

How does a user get the enhanced local search feature?
The enhanced local search is available as part of the latest Sprint SmartView software. It allows 
you to submit custom queries or use one of the predefined finder services that are included by 
default.
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What is a GPS Application?
A GPS Application is an application that uses NMEA data to get regular location coordinate 
updates and values typically displayed in a user interface. Examples of GPS Applications 
are: Microsoft Streets & Trips and Map Point.

How do I develop GPS Applications?
Device GPS SDKs are available. We recommend joining the Sprint Nextel Software 
Application Development Program to get the appropriate and latest SDK information. 

GPS and Sprint SmartView

How do I enable GPS?
By unchecking Disable GPS in the Location/GPS tab, and setting Mode to “Automatic” in 
the CDMA version of the Device Property window under (to reach this window, select 

Tools > Settings > Hardware, then click the  button next to the Mobile heading).

How do I display the GPS Receiver?
If you are using the new interface, the GPS Search Menu appears at the bottom of the main 
window. Hovering over the satellite icon near the upper-right corner of the Main Window, 
displays the GPS data received. Clicking this icon displays the GPS Application Launch 
Menu.

If you are using the classic interface, you can open the GPS Bar by clicking on the GPS Bar 
in the Main Window of the Sprint SmartView software.

Does GPS work when Privacy is On?
No. Turning privacy on (by closing the GPS Bar in the “classic” user interface) means you 
do not want your Mobile Broadband Device to be discoverable via GPS. Thus, GPS is not 
started on the device.

How do I start GPS NMEA?
Connect your GPS-Capable Mobile Broadband Device and start the Sprint SmartView 
software. If you are using the “new” interface, NMEA will be started automatically when you 
perform a location-based search or launch an application from the GPS Application Launch 
Menu.

If you are using the “classic” interface, click the GPS button in the Main Window to open the 
GPS Bar and then click the NMEA Start Button (the yellow arrow on the right end of the bar) 
to start NMEA output. GPS NMEA should now be available to be used with any GPS 
NMEA183-compliant applications.

Note GPS Services are not supported if the Mode field is set to “EVDO Only.” Mode MUST 
be set to “Automatic” or “1xRTT.”
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How do I configure my NMEA port?
Three NMEA ports are created when you install the Sprint SmartView software (see “GPS/
NMEA COM Ports” on page 98 for more information on the ports created). A particular port may 
be assigned to a launched GPS application when you add it by entering the port number in the 
Parameters box of the Application Configuration window (see “Adding a GPS Application to 
the GPS Applications Window” on page 100).

How do I stop GPS NMEA?
If you are using the “classic interface, click the NMEA Start Button again to stop NMEA Output 
(this button is found on the bottom right of GPS Bar). If you are using the new interface, NMEA 
can only be shut down by closing the Sprint SmartView application.

How do I use GPS Applications with a Sprint GPS-Capable Device?
There are essentially three things you must do to make a GPS application work with your Sprint 
GPS-capable device:

● Add the GPS application according to the instructions in “Adding a GPS Application to 
the GPS Applications Window” on page 100, making sure that you properly assign an 
NMEA port number to the application.

● Typically, the application that you wish to use has to be informed of the port number it 
has been assigned. Consult the documentation for the application you wish to use to see 
where you need to enter this information.

● Start GPS NMEA in the Sprint SmartView software. See “How do I start GPS NMEA” 
(above).

Can LBS/GPS be used when the device is configured for NDIS?
Yes, both Location Based Services and GPS Services are supported while the device is in NDIS 
mode.
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Subscriber Agreement 
General Terms and Conditions of Service 

Please note these terms may not be the most current version. A current version of the terms is 
available at our web site or upon request.
Para solicitar esta literatura en español, por favor contactar a 1-800-777-4681.

Basic Definitions
In this document: (1) “we,” “us,” “our,” and “Sprint” mean Sprint Solutions, Inc. and its affiliates 
doing business as Sprint or Sprint PCS; (2) “you,” “your,” “customer,” and “user” mean an 
account holder or user with us; (3) “Device” means any phone, device, accessory or other 
product we sell to you or that is active on your account with us; and (4) “Service” means our 
offers, rate plans, options, wireless services or Devices on your account with us.

The Subscriber Agreement 
The Subscriber Agreement (“Agreement”) is a contract under which we provide and you accept 
our Services. In addition to these Terms and Conditions of Service (“Ts&Cs”), there are several 
parts to the Agreement, including, but not limited to, the detailed plan or other information on 
Services we provide or refer you to during the sales transaction, and any confirmation materials 
we may provide you. It is important that you carefully read all of the terms of the Agreement.

Services Covered By These Ts&Cs & Additional Terms
These Ts&Cs apply to our standard wireless Services and any other Service we offer you that 
references these Ts&Cs. Different terms will apply to most business accounts. Additional terms 
will apply when you use certain Services, typically those you can access online (for example, 
picture/video Services, online forums, etc.). Additional terms will also apply if you activate 
Services as part of a bundle with another company’s services (for example, cable services, 
home phone services, etc.). The additional terms for bundled Services may either modify or 
replace certain provisions in these Ts&Cs, including terms relating to activation, invoicing/
payment, and disputing charges. Also, a different dispute resolution provision may apply to 
services provided by another company (the dispute resolution provisions in this Agreement still 
apply to our Services). You will be provided details on any additional terms with your selection 
of any bundled Service.

Our Policies
Services are subject to our business policies, practices and procedures (“Policies”), including, 
but not limited to, our Privacy Policy and Acceptable Use Policy and Visitor Agreement – both 
available at our web site. You agree to all of our Policies when you use our Services. Our 
Policies are subject to change at anytime with or without notice. 
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When You Accept The Agreement
You must have the legal capacity to accept the Agreement. You accept the Agreement when 
you do any of the following: (a) sign a contract with us on paper or electronically; (b) accept 
Agreement through an oral or electronic statement; (c) attempt to or in any way use the 
Services; (d) pay for the Services; or (e) open any package or start any program that says 
you are accepting the Agreement when doing so. If you don’t want to accept the Agreement, 
don’t do any of these things. 

Term Commitments & Early Termination Fees
Many of the Services (for example, rate plans and Device discounts) that we offer require you 
to maintain certain Services with us for a minimum term, usually 1 or 2 years (“Term 
Commitment”). You will be charged a fee (“Early Termination Fee”) for each line of Service 
that you terminate early (i.e., prior to satisfying the Term Commitment) or for each line of 
Service that we terminate early for good reason (for example, violating the payment or 
other terms of the Agreement). Early Termination Fees are a part of our rates. Your exact 
Term Commitment and Early Termination Fee may vary based on the Services you select 
and will be disclosed to you during the sales transaction. Carefully review any Term 
Commitment and Early Termination Fee requirements prior to selecting Services. After you 
have satisfied your Term Commitment, your Services continue on a month-to-month basis 
without any Early Termination Fee, unless you agree to extend your Term Commitment or 
agree to a new Term Commitment. As explained directly below, there are instances when 
you will not be responsible for an Early Termination Fee for terminating Services early. 

When You Don’t Have To Pay An Early Termination Fee
You aren’t responsible for paying an Early Termination Fee when terminating Services: (a) 
provided on a month-to-month basis; (b) consistent with our published trial period return 
policy; or (c) in response to a materially adverse change we make to the Agreement as 
described directly below. 

Our Right To Change The Agreement & Your Related Rights
We may change any part of the Agreement at any time, including, but not limited to, rates, 
charges, how we calculate charges, or your terms of Service. We will provide you notice of 
material changes, and may provide you notice of non-material changes, in a manner 
consistent with this Agreement (see “Providing Notice To Each Other Under The 
Agreement” section). If a change we make to the Agreement is material and has a material 
adverse effect on Services under your Term Commitment, you may terminate each line of 
Service materially affected without incurring an Early Termination Fee only if you: (a) call 
us within 30 days after the effective date of the change; and (b) specifically advise us that 
you wish to cancel Services because of a material change to the Agreement that we have 
made. If you do not cancel Service within 30 days of the change, an Early Termination Fee 
will apply if you terminate Services before the end of any applicable Term Commitment.
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Our Right To Suspend Or Terminate Services
We can, without notice, suspend or terminate any Service at any time for any reason, 
including, but not limited to: (a) late payment; (b) exceeding an Account Spending Limit (“ASL”); 
(c) harassing/threatening our employees or agents; (d) providing false information; (e) 
interfering with our operations; (f) using/suspicion of using Services in any manner restricted by 
or inconsistent with the Agreement; (g) breaching the Agreement, including our Policies; (h) 
providing false, inaccurate, dated or unverifiable identification or credit information, or becoming 
insolvent or bankrupt; (i) modifying a Device from its manufacturer specifications; or (j) if we 
believe the action protects our interests, any customer’s interests or our network. 

Your Ability To Change Services & When Changes Are Effective
You typically can change Services upon request. In some instances, changes may be 
conditioned on payment of an Early Termination Fee or certain other charges, or they may 
require you to accept a new Term Commitment. Changes to Services are usually effective at the 
start of your next full invoicing cycle. If the changes take place sooner, your invoice may reflect 
pro-rated charges for your old and new Services.

Your Right To Terminate Services
You can terminate Services at any time by calling us and requesting that we deactivate all 
Services. You are responsible for all charges billed or incurred prior to deactivation. If Services 
are terminated before the end of your invoicing cycle, we won’t prorate charges to the date of 
termination and you won’t receive a credit or refund for any unused Services. Except as 
provided above, you must also pay us an Early Termination Fee for each line of Service that 
you terminate early. 

Credit Checks & Credit Information
We agree to provide you Services on the condition you have and maintain satisfactory credit 
according to our standards and policies. You agree to provide information we may request or 
complete any applications we may provide you to facilitate our review. We rely on the credit 
information you furnish, credit bureau reports or other data available from commercial credit 
reference services, and other information (such as payment history with us) to determine 
whether to provide or continue to provide you Services. The Services we offer you can vary 
based on your credit history. We may at any time, based on your credit history, withdraw or 
change Services, or place limits or conditions on the use of our Services. You agree to provide 
us updated credit information upon request. We may provide your payment history and other 
account billing/charge information to any credit reporting agency or industry clearinghouse. 

Account Spending Limits (“ASL”)
An ASL is a temporary or permanent limit (typically based on credit history, payment history, or 
to prevent fraud) we place on the amount of unpaid charges you can accumulate on your 
account, regardless of when payment on those charges is due. We reserve the right to 
determine which charges count towards an ASL. If you have an ASL, we may suspend your 
Services without prior notice if your account balance reaches the ASL, even if your account is 
not past due. We may impose or increase an ASL at any time with notice. An ASL is for our 
benefit only and should not be relied on by you to manage usage. 
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Deposits & Returning Deposits
We may at any time require a deposit, as a guarantee of payment, for you to establish or 
maintain Service (“Deposit”). By providing us a Deposit, you grant us a security interest for 
all current or future amounts owed to us. We may change the Deposit at any time with 
notice. You can’t use a Deposit to make or delay payments. The Deposit, the length of time 
we hold the Deposit, and changes to the Deposit are determined based on your credit 
history, payment history and other factors. Unless prohibited by law, we may mix Deposits 
with our other funds and it won’t earn interest and we reserve the right to return the Deposit 
as a credit on your invoice at anytime. If your Services are terminated for any reason, we 
may keep and apply your Deposit to any outstanding charges. We’ll send any remaining 
portion of the Deposit to your last known address within 90 days after your final invoice – if 
it is returned to us, we will forward it on to the appropriate state authorities to the extent 
required by law. 

Restrictions On Using Services
You can’t use our Services: (a) to transmit content/messages that are, or in any manner that 
is, illegal, fraudulent, threatening, abusive, defamatory, or obscene; (b) in a way that could 
cause damage or adversely affect our customers, reputation, network, property or Services; 
(c) to communicate any unsolicited commercial voice, text, SMS, or other message; (d) to 
infringe on the copyright of another, or upload or transmit any “virus,” “worm,” or malicious 
code; or (e) in any way prohibited by the terms of our Services, the Agreement or our 
Policies.

Your Device, Number & E-mail Address; Caller ID
We don’t manufacture any Device we might sell to you or that is associated with our 
Services, and we aren’t responsible for any defects, acts or omissions of the manufacturer. 
The only warranties on your Device are the limited warranties given to you by the 
manufacturer directly or that we pass through. Your Device is designed to be activated on 
the Sprint network and in other coverage areas we make available to you. As programmed, it 
will not accept wireless service from another carrier. Except for any legal right you may have 
to port/transfer your phone number to another carrier, you have no and cannot gain any (for 
example, through publication, use, etc.) proprietary, ownership or other rights to any phone 
number, identification number, e-mail address or other identifier we assign to you, your 
Device or your account. We’ll notify you if we decide to change or reassign them. Your 
CDMA Sprint PCS phone has a software programming lock that protects certain of the 
handset’s operating parameters against unauthorized reprogramming. If you wish to obtain 
the software program lock code for your CDMA Sprint PCS phone, please visit Sprint.com or 
call 1-888-211-4727 for information and eligibility requirements.

Porting/Transferring Phone Numbers
We don’t guarantee that number transfers to or from us will be successful. If you authorize 
another carrier to transfer a number away from us, that is considered a request by you to us 
to terminate all of the Services associated with that number. You’re responsible for all 
charges billed or incurred prior to deactivation and for any applicable Early Termination Fees.
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Coverage; Where Your Device Will Work
Our coverage maps are available at our stores and on our web site. The specific network 
coverage you get will depend on the radio transmissions your Device can pick up and Services 
you’ve chosen. Our coverage maps provide high level estimates of our coverage areas when 
using Services outdoors under optimal conditions. Coverage isn’t available everywhere. 
Estimating wireless coverage and signal strength is not an exact science. There are gaps in 
coverage within our estimated coverage areas that, along with other factors both within and 
beyond our control (network problems, software, signal strength, your Device, structures, 
buildings, weather, geography, topography, etc.), may result in dropped and blocked 
connections, slower data speeds, or otherwise impact the quality of Service. Services that rely 
on location information, such as E911 and GPS navigation, depend on your Device’s ability to 
acquire satellite signals (typically not available indoors) and network coverage. 

Roaming
“Roaming” typically refers to coverage on another carrier’s network that we make available to 
you based on our agreements with other carriers. These agreements may change from time to 
time and Roaming coverage is subject to change. Your ability to receive Roaming coverage 
depends on the radio transmissions your Device can pick up. You can pick up Roaming 
coverage both within and outside our network coverage areas. Your Device will generally 
indicate when you’re roaming. Depending on your Services, separate charges or limits on the 
amount of minutes used while roaming may apply. Certain Services may not be available or 
work the same when roaming (including data Services, voicemail, call waiting, etc.).

About Data Services & Content
Our data Services and your Device may allow you to access the internet, text, pictures, video, 
games, graphics, music, email, sound and other materials (“Data Content”) or send Data 
Content elsewhere. Some Data Content is available from us or our vendors, while other Data 
Content can be accessed from others (third party web sites, games, ringers, etc.). We make 
absolutely no guarantees about the Data Content you access on your Device. Data Content may 
be: (1) unsuitable for children/minors; (2) unreliable or inaccurate; or (3) offensive, indecent or 
objectionable. You’re solely responsible for evaluating the Data Content accessed by you or 
anyone on your account. We strongly recommend you monitor data usage by children/minors. 
Data Content from third parties may also harm your Device or its software. To protect our 
network, Services, or for other reasons, we may place restrictions on accessing certain Data 
Content (such as certain web sites, applications, etc.), impose separate charges, limit throughput 
or the amount of data you can transfer, or otherwise limit or terminate Services. If we provide you 
storage for Data Content you have purchased, we may delete the Data Content with notice or 
place restrictions/limits on the use of storage areas. You may not be able to make or receive 
voice calls while using data Services.
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Specific Terms & Restrictions On Using Data Services
In addition to the rules for using all of our other Services, unless we identify the Service or 
Device you have selected as specifically intended for that purpose (for example, wireless 
routers, Data Link, etc.), you can’t use our data Services: (1) with server devices or host 
computer applications, or other systems that drive continuous heavy traffic or data sessions; 
and (2) as a substitute or backup for private lines or frame relay connections. We reserve the 
right to limit, suspend or constrain any heavy, continuous data usage that adversely impacts 
our network performance or hinders access to our network. If your Services include web or 
data access, you also can’t use your Device as a modem for computers or other equipment, 
unless we identify the Service or Device you have selected as specifically intended for that 
purpose (for example, with “Phone as Modem” plans, Sprint Mobile Broadband Device 
plans, Wireless Router plans, etc.).

Activation & Miscellaneous Charges
Based on our Policies, we may charge activation, prepayment, reactivation, program or 
other fees to establish or maintain Services. Certain transactions may also be subject to a 
charge (for example, convenience payment, changing phone numbers, handset upgrades, 
etc.). You will be provided notice of these types of fees before we complete the requested 
transaction.

Account & Service Charges; Pro-rating; Unused Minutes
You are responsible for all charges associated with your account and the Services on your 
account, no matter who adds or uses the Services. Charges include, but are not limited to, 
the monthly recurring charges, usage charges, taxes, surcharges and fees associated with 
your Services. These charges are described or referred to during the sales transaction, in our 
marketing materials, and in confirmation materials we may send to you. If you (the account 
holder) allow end users to access or use your Devices, you authorize end users to access, 
download and use Services.

How We Calculate Your Charges For Billing Purposes
Regular Voice Calls: We round up partial minutes of use to the next full minute. Time starts 
when you press “Talk” or your Device connects to the network and stops when you press 
“End” or the network connection otherwise breaks. You’re charged for all calls that connect, 
even to answering machines. You won’t be charged for unanswered calls or if you get a 
busy signal. For incoming calls answered, you’re charged from the time shortly before the 
Device starts ringing until you press END or the network connection otherwise breaks. If 
charges vary depending on the time of day that you place or receive calls (e.g., Nights and 
Weekend plans), you’re charged for the entire call based on the rate that applies to the time 
period in which the call starts.
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Walkie-Talkie Charges: Charges for walkie-talkie calls are billed to the person who starts the call 
and calculated by multiplying the duration of the call by the applicable rate and number of 
participants. You’re charged at least 6 seconds of airtime for each call you start; subsequent 
communications in the same call are rounded up to and billed to the next second. Time begins 
when you press any button to start a walkie-talkie call and ends approximately 6 seconds after 
completion of a communication to which no participant responds – subsequent walkie-talkie 
communications are considered new calls. Depending on your plan, nationwide, international or 
group walkie-talkie calls may use the local walkie-talkie minutes in your plan and result in 
additional charges. Responses to call alert transmissions are treated as new walkie-talkie 
transmissions even when responding within 6 seconds of receiving the alert. Walkie-talkie billing 
methods are subject to change as we introduce new walkie-talkie Services. 

Data Usage: Unless we specifically tell you otherwise, data usage is measured in bytes, kilobytes 
and megabytes – not in minutes/time. 1024 bytes equals 1 kilobyte (“KB”), and 1024 KB equals 
1 megabyte. Bytes are rounded up to kilobytes, so you will be charged at least 1 KB for each 
data usage session (“data session”). Rounding occurs at the end of each data session, and 
sometimes during a data session. Depending on your data Services, usage may be charged 
against an allowance or on a fixed price per KB. If you are charged on a fixed price per KB, any 
fractional cents will be rounded up to the next cent. You are charged for all data directed to your 
Device’s internet address, including data sessions you did not initiate and for incomplete 
transfers. As long as your Device is connected to our data network, you may incur data charges. 
Examples of data you will be charged for includes the size of a requested file or Data Content 
(game, ringer, etc.), web page graphics (logos, pictures, banners, advertisement, etc.), additional 
data used in accessing, transporting and routing the file on our network, data from partial or 
interrupted downloads, re-sent data, and data associated with unsuccessful attempts to reach 
web sites or use applications. These data charges are in addition to any charges for the Data 
Content itself (game, ringer, etc.). Data used and charged to you will vary widely, even between 
identical actions or data sessions. Estimates of data usage – for example, the size of 
downloadable files – are not reliable predictors of actual usage. Your bill won’t separately list the 
number of KB attributed to a specific action/data session.

Your Bill
Your bill provides you notice of your charges. It reflects monthly recurring charges (usually billed 
one bill cycle in advance) and usage/transaction specific charges (usually billed in the bill cycle 
in which they’re incurred). Some usage charges, such as those that depend on usage 
information from a third party, may be billed in subsequent bill cycles and result in higher than 
expected charges for that month. Bill cycles and dates may change from time to time. Your bill 
may also include other important notices (for example, changes to this Agreement, to your 
Service, legal notices, etc.). Your paper bill may not include individual call detail. Your call detail 
is available online. Paper bills with call detail may be subject to an additional charge. If you 
choose internet billing, you will not receive paper bills.
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Your Payments; Late Fees 
Payment is due in full as stated on your bill. If we do not receive payment in full by the date 
specified on your bill, a late payment charge, which may be charged at the highest rate 
permissible by law, may be applied to the total unpaid balance. We may also charge you 
any costs we pay to a collection agency to collect unpaid balances from you. If we bill you 
for amounts on behalf of a third party, payments received are first applied to our charges. 
You may be charged additional fees for certain methods of payment. We may charge you, 
up to the highest amount permitted by law, for returned checks or other payments paid by 
you and denied for any reason by a financial institution. Acceptance of payments (even if 
marked “paid in full”) does not waive our right to collect all amounts that you owe us. We 
may restrict your payment methods to cashier’s check, money order, or other similar secure 
form of payment at any time for good reason.

Taxes & Government Fees 
You agree to pay all federal, state and local taxes, fees and other assessments that we’re 
required by law to collect and remit to the government on the Services we provide to you. 
These charges may change from time to time without advance notice. If you’re claiming any 
tax exemption, you must provide us with a valid exemption certificate. Tax exemptions 
generally won’t be applied retroactively.

Surcharges 
You agree to pay all surcharges (“Surcharges”), which include, but are not limited to: Federal 
Universal Service, various regulatory fees, Sprint administrative charges, gross receipts 
charges, and charges for the costs we incur in complying with governmental programs. 
Surcharges are not taxes and are not required by law. They are rates we choose to collect 
from you and are kept by us in whole or in part. The number and type of Surcharges may 
vary depending upon the location of your primary billing address and can change over 
time. We determine the rate for these charges and these amounts are subject to change 
as are the components used to calculate these amounts. We will provide you notice of any 
changes to Surcharges in a manner consistent with this Agreement (see “Providing Notice 
To Each Other Under The Agreement” section). However, since some Surcharges are based 
on amounts set by the government or based on government formulas, it will not always be 
possible to provide advance notice of new Surcharges or changes in the amount of existing 
Surcharges. Information on Surcharges is provided during the sales transaction and is 
available on our website.

Disputing Charges - You Must Still Pay Undisputed Charges 
Any dispute to a charge on your bill must be made within 60 days of the date of the bill that initially 
contained the charge. Disputes can only be made by calling or writing us as directed on your 
invoice or elsewhere. You accept all charges not properly disputed within the above time period – 
undisputed charges must still be paid as stated on your bill.
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Protecting Our Network & Services 
We can take any action to: (1) protect our network, our rights and interests, or the rights of 
others; or (2) optimize or improve the overall use of our network and Services. Some of these 
actions may interrupt or prevent legitimate communications and usage – for example, message 
filtering/blocking software to prevent SPAM or viruses, limiting throughput, limiting access to 
certain web sites, applications or other Data Content, etc. For additional information on what we 
do to protect our customers, network, Services and equipment, see our Acceptable Use Policy 
and Visitor Agreement at our website.

Your Privacy 
You agree to the terms of our Privacy Policy, available at our web site, when you use our 
Services. This policy may change from time to time, so review this policy with regularity and 
care. Among other things, the policy includes important information on what information we 
collect about you, how we use that information, and with whom we share that information (for 
example, to provide you certain Services, to protect our rights and interests, to respond to legal 
process, to facilitate a merger, etc.). Also, to ensure the quality of our Services and for other 
lawful purposes, we may also monitor or record calls between us (for example, your 
conversations with our customer service or sales departments). If you do not agree with the 
terms of our Privacy Policy, do not purchase or use our Services.

We encourage you (the account holder) to protect the privacy of your account information by 
establishing passwords (including for your online accounts), which may include an answer to a 
backup shared secret question. These authenticators will be used when you access your 
account. This is the most effective way for you to protect your account. We treat the holder of 
your password(s) and/or your answer to a backup shared secret question as an authorized 
person on your account. Please do not share your authentication information with anyone that 
you do not wish to have access to your account. You agree that we may contact you in our 
discretion about important account related matters through the contact information you provide, 
through the Services or Devices to which you subscribe or through other available means. We 
also may allow you to set preferences for your preferred means of contact. 

As we provide telecommunications Products and Services to you (the account holder), we 
develop information about the quantity, technical configuration, type and destination of 
telecommunications Products and Services you use, as well as some other information found 
on your bill (“CPNI”). Under federal law, you have the right, and we have a duty, to protect the 
confidentiality of your CPNI. For example, we implement safeguards that are designed to protect 
your CPNI, including authentication procedures when you contact us. For some accounts with a 
dedicated Sprint representative, we may rely on contacting your pre-established point of contact 
as the standard authentication measure.
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Location Based Services 
Our network generally knows the location of your Device when it is outdoors and/or turned 
on. By using various technologies to locate your Device, we can provide enhanced 
emergency 911 services, and optional location-sensitive services provided by us or a third 
party. Environmental factors (such as structures, buildings, weather, geography, landscape, 
and topography) can significantly impact the ability to access your Device’s location 
information and use of location-sensitive services. The terms and conditions of any location-
sensitive service that you purchase from us may provide more information about how 
location information is used and disclosed. Use of some of location-sensitive services may 
require network coverage. If any Device on your account uses a location-sensitive service, 
you (the account holder) authorize the end user to download, access and use location 
sensitive services and agree to clearly and regularly notify the end user of your Device that 
their location may be tracked or discovered. For additional information on location-sensitive 
services, see our Privacy Policy at our website.

911 Or Other Emergency Calls 
Public Safety Officials advise that when making 911 or other emergency calls, you should 
always be prepared to provide your location information. Unlike traditional wireline phones, 
depending on a number of factors (e.g., whether your Device is GPS enabled, where you are, 
whether local emergency service providers have upgraded their equipment, etc.), 911 
operators may not know your phone number, your location or the location of your Device. In 
certain circumstances, an emergency call may be routed to a state patrol dispatcher or 
alternative location set by local emergency service providers. Enhanced 911 service (“E911”), 
where enabled by local emergency authorities, uses GPS technology to provide location 
information. Even when available, however, E911 does not always provide accurate location 
information. If your Device is indoors or for some other reason cannot acquire a satellite 
signal, you may not be located. Some Devices have a safety feature that prevents use of the 
keypad after dialing 911 – you should follow voice prompts when interacting with emergency 
service providers employing IVR systems to screen calls.

If Your Device Is Lost or Stolen 
Call us immediately if your Device is lost or stolen because you may be responsible for 
usage charges before you notify us of the alleged loss or theft. You agree to cooperate if we 
choose to investigate the matter (provide facts, sworn statements, etc.). We may not waive 
any Early Termination Fees if you choose to terminate Services as a result of loss or theft of 
your Device.

Disclaimer of Warranties 
WE MAKE NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED, INCLUDING 
(TO THE EXTENT ALLOWED BY LAW) ANY IMPLIED WARRANTY OF MERCHANTABILITY, 
NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE CONCERNING YOUR 
SERVICES (INCLUDING YOUR DEVICE). WE DON’T PROMISE UNINTERRUPTED OR 
ERROR-FREE SERVICES AND DON’T AUTHORIZE ANYONE TO MAKE WARRANTIES ON 
OUR BEHALF.
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You Agree We Are Not Responsible For Certain Problems 
You agree that neither we nor our vendors, suppliers or licensors are responsible for any 
damages resulting from: (a) anything done or not done by someone else; (b) providing or 
failing to provide Services, including, but not limited to, deficiencies or problems with a Device 
or network coverage (for example, dropped, blocked, interrupted calls/messages, etc.); (c) traffic 
or other accidents, or any health-related claims relating to our Services; (d) Data Content or 
information accessed while using our Services; (e) an interruption or failure in accessing or 
attempting to access emergency services from a Device, including through 911, Enhanced 911 
or otherwise; (f) interrupted, failed, or inaccurate location information services, (g) information or 
communication that is blocked by a spam filter, or (h) things beyond our control, including acts 
of God (for example, weather-related phenomena, fire, earthquake, hurricane, etc.), riot, strike, 
war, terrorism or government orders or acts.

You Agree Our Liability Is Limited - No Consequential Damages.
TO THE EXTENT ALLOWED BY LAW, OUR LIABILITY FOR MONETARY DAMAGES FOR ANY 
CLAIMS YOU MAY HAVE AGAINST US IS LIMITED TO NO MORE THAN THE PROPORTIONATE 
AMOUNT OF THE SERVICE CHARGES ATTRIBUTABLE TO THE AFFECTED PERIOD. UNDER 
NO CIRCUMSTANCES ARE WE LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL, PUNITIVE 
OR SPECIAL DAMAGES OF ANY NATURE WHATSOEVER ARISING OUT OF OR RELATED TO 
PROVIDING OR FAILING TO PROVIDE SERVICES IN CONNECTION WITH A DEVICE, 
INCLUDING, BUT NOT LIMITED TO, LOST PROFITS, LOSS OF BUSINESS, OR COST OF 
REPLACEMENT PRODUCTS AND SERVICES.

DISPUTE RESOLUTION 

We Agree To First Contact Each Other With Any Disputes

We each agree to first contact each other with any disputes and provide a written description of the 
problem, all relevant documents/information and the proposed resolution. You agree to contact us with 
disputes by calling or writing us as instructed on your invoice. We will contact you by letter to your billing 
address or on your Device.

Instead Of Suing In Court, We Each Agree To Arbitrate Disputes

We each agree to finally settle all disputes (as defined and subject to any specific exceptions below) only 
by arbitration. In arbitration, there’s no judge or jury and review is limited. However, just as a court would, 
the arbitrator must honor the terms and limitations in the Agreement and can award the same damages 
and relief, including any attorney’s fees authorized by law. The arbitrator’s decision and award is final and 
binding, with some exceptions under the Federal Arbitration Act (“FAA”), and judgment on the award may 
be entered in any court with jurisdiction. We each also agree as follows:

(1) “Disputes” are any claims or controversies against each other related in any way to our Services or the 
Agreement, including, but not limited to, coverage, Devices, privacy, or advertising, even if it arises after 
Services have terminated – this includes claims you bring against our employees, agents, affiliates or 
other representatives, or that we bring against you.
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No Class Actions 
TO THE EXTENT ALLOWED BY LAW, WE EACH WAIVE ANY RIGHT TO PURSUE DISPUTES 
ON A CLASSWIDE BASIS; THAT IS, TO EITHER JOIN A CLAIM WITH THE CLAIM OF ANY 
OTHER PERSON OR ENTITY, OR ASSERT A CLAIM IN A REPRESENTATIVE CAPACITY ON 
BEHALF OF ANYONE ELSE IN ANY LAWSUIT, ARBITRATION OR OTHER PROCEEDING.

No Trial By Jury 
TO THE EXTENT ALLOWED BY LAW, WE EACH WAIVE ANY RIGHT TO TRIAL BY JURY IN 
ANY LAWSUIT, ARBITRATION OR OTHER PROCEEDING.

(2) If either of us wants to arbitrate a dispute, we agree to send written notice to the other providing a 
description of the dispute, previous efforts to resolve the dispute, all supporting documents/information, 
and the proposed resolution. Notice to you will be sent to your billing address and notice to us will be 
sent to: General Counsel; Arbitration Office; 2001 Edmund Halley Drive VARESP0513-502; Reston, 
Virginia 20191. We agree to make attempts to resolve the dispute. If we cannot resolve the dispute within
forty-five (45) days of receipt of the notice to arbitrate, then we may submit the dispute to formal 
arbitration. 

(3) The FAA applies to this Agreement and arbitration provision. We each agree the FAA’s provisions, not
state law, govern all questions of whether a dispute is subject to arbitration.

(4) The arbitration will be administered by the National Arbitration Forum (“NAF”) under its arbitration 
rules. If any NAF rule conflicts with the terms of the Agreement, the terms of the Agreement apply. You 
can obtain procedures, rules, and fee information from the NAF at 
1-800-474-2371 or www.adrforum.com. 

(5) Unless we each agree otherwise, the Arbitration will be conducted by a single neutral arbitrator and 
will take place in the county of your last billing address. The federal or state law that applies to the 
Agreement will also apply during the arbitration.

(6) We each agree not to pursue arbitration on a classwide basis. We each agree that any arbitration will 
be solely between you and us (not brought on behalf of or together with another individual’s claim). If for 
any reason any court or arbitrator holds that this restriction is unconscionable or unenforceable, then our 
agreement to arbitrate doesn’t apply and the dispute must be brought in court. 

(7) We each are responsible for our respective costs relating to counsel, experts, and witnesses, as well
as any other costs relating to the arbitration. However, we will cover any arbitration administrative or filing
fees above: (a) $25 if you are seeking less than $1,000 from us; or (b) the equivalent court filing fees for
a court action in the appropriate jurisdiction if you are seeking $1,000 or more from us.

Exceptions To Our Agreement To Arbitrate Disputes
Either of us may bring qualifying claims in small claims court. In addition, this arbitration provision does 
not prevent you from filing your dispute with any federal, state or local government agency that can, if the
law allows, seek relief against us on your behalf.
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Indemnification 
You agree to indemnify, defend and hold us harmless from any claims arising out of your 
actions, including, but not limited to, failing to provide appropriate notices regarding location-
sensitive services (see “Location Based Services” section), failure to safeguard your passwords, 
backup question to your shared secret question or other account information, or violating this 
Agreement, any applicable law or regulation or the rights of any third party.

Providing Notice To Each Other Under The Agreement 
Except as the Agreement specifically provides otherwise, you must provide us notice by calling 
or writing us as instructed on your invoice. We will provide you notice in your bill, 
correspondence to your last known billing address, to any fax number or e-mail address you’ve 
provided us, by calling you on your home phone or Device, by voice message on your Device 
or home phone, or by text message on your Device.

Other Important Terms 
Subject to federal law or unless the Agreement specifically provides otherwise, this Agreement 
is governed solely by the laws of the state encompassing the area code assigned to your 
Device, without regard to the conflicts of law rules of that state. If either of us waives or doesn’t 
enforce a requirement under this Agreement in an instance, we don’t waive our right to later 
enforce that requirement. Except as the Agreement specifically provides otherwise, if any part of 
the Agreement is held invalid or unenforceable, the rest of this Agreement remains in full force 
and effect. This Agreement isn’t for the benefit of any 3rd party except our corporate parents, 
affiliates, subsidiaries, agents, and predecessors and successors in interest. You can’t assign 
the Agreement or any of your rights or duties under it. We can assign the Agreement. The 
Agreement and the documents it incorporates make up the entire agreement between us and 
replaces all prior written or spoken agreements – you can’t rely on any contradictory 
documents or statements by sales or service representatives. The rights, obligations and 
commitments in the Agreement that, by their nature, would logically continue beyond the 
termination of Services (including, but not limited to, those relating to billing, payment, 911, 
dispute resolution, no class action, no jury trial), survive termination of Services.
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